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Az elso6 lépések utmutatordl

Kinek készult az utmutato és mit tartalmaz?

Ez az utmutato projektvezetbk szamara késziilt. A projekt életciklusara fokuszal, a projekt
létrehozasatél kezdve, a projektcsomagok kezelésén at egészen a projekt befejezéséig.

MEGJEGYZES Az SDL Studio GroupShare Project szerver segitségével végzett on-line
munkafolyamatokrél az SDL Trados Studio sugé vidediban és leirasaiban
talal informéciot.

Az utmutatd hasznalata

Gyakorlashoz hasznalhatja a program telepitésekor kapott mintafajlokat. Minden feladat az
elézére épll, tehat ha a mintafajlokat hasznalja, akkor az utasitasokat Iépésrél Iépésre kell
végrehajtania.

! i Ez a szimbdélum mutatja a feladatok elvégzéséhez sziikséges
- mintafajlokat és azok helyét.

Az elérési utvonalat a Microsoft Windows 7 operacios rendszer alapjan
hataroztuk meg.

®Tipp Ez a szimbdlum azt mutatja, hogy az éppen végrehaijtott feladattal
kapcsolatban tovabbi informaciokat tartalmazé tipp érhetd el.

MEGJEGYZES Ez a szimbdlum azt mutatja, hogy az éppen végrehajtott feladattal
kapcsolatban fontos informaciét tudhat meg.

Billentyliparancsok Minden billenty(it, melyet le kell nyomnia billentylizetén a kovetkez6
karaktertipussal jeloltink: Ctrl+Enter.

Egyéb informacioforrasok

Alabb talalhaté néhany informacioforras, amelyhez hozzaférhet:

e SDL Trados Studio sugé

e SDL GroupShare sugo

e SDL GroupShare telepitési utmutatd

e SDL Trados Studio adatmigraciés Utmutatd

e Dokumentumok forditasa és ellenérzése — Elsé I1épések utmutatd
e Forditasi memodria menedzsment — Elsé I1épések utmutatd

Dokumentumok forditasa és ellenérzése — Elsé |épések Utmutatd
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Az SDL Trados Studio-rol

Leiras

Az SDL Trados Studio lehetévé teszi kiilonbdz6 szervezetek szamara, hogy forditasi projektjeiket
minden szempontbdl hatékonyan kezelhessék. Az SDL Trados Studio magaban foglalja a
projektvezetdk, forditok, szerkeszték, lektorok és egyéb nyelvi szakérték altal hasznalt
projektmenedzsment és szamitogéppel tamogatott forditasi (CAT) eszkdzdket. Ezek kdnnyen
alkalmazhat6 nézetekben talalhaték, amelyeket az Onnek legmegfelelébb médon rendezhet.

Nézetek
Az SDL Trados Studio-ban egy nézet megjelenitéséhez kattintson arra a gombra, amely a nézet
nevét viseli vagy az adott nézet ikonjara. A nézet gombok a navigaciés panel aljan talalhatok.

[« IR SOL Trados Studio - Project 3 - B =
Heme View Add-Ins Help

Project Upgrade Translation Align Create AutoSuggest Open Terminclogy Software Show
Settings Memories Documents = Dicticnary Retrofit File | Management | Localization | Shortcuts
Configuration Translation Memory ~
Welcome <
OpenExchange Apps
[¢€) sDL Batch Find and Replace
"y HOME GET STARTED MORE LATEST NEW:
[hu SDL T-Window for Clipboard RESOURCES :

[ soLTxm

SDL XLIFF Converter for Microsoft Of .
New Project

# Goto OpsnBuchangs App Stors - Launch this wizard to set up a translation project with multiple files, translation

memories, termbases and other resources - ideal for projects going into one
or more languages. Watch Video

. , AP Translate Single Document
,,,,,,,,, 135 Use this to translate a single document in SDL Trados Studio into a single
target language using a single-file project. Watch Video

ﬂ Welcome

Projects @ Open Package
-
- Open a project package sent to you. Once opened it will be added to your
2 Fies list in the Pro view. ¥ 1 i

jects view. You can work with packages from SDL Trados Studio

| SDL WorldServer, SDL TMS and other systems. Watch Video

Reports B

L .

& Editor SDL|T"“°’S{“'”° Open GroupShare Project

Open a project shared on SDL Studio GroupShare for collaboration.
n

&

B Translation Memories

Dokumentumok forditasa és ellenérzése — Elsé |épések Utmutatd
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Nézet

=g Welcome

W Projects (Projektek)

Files (Fajlok)

2 '
Reports (Jelentések)

a Editor (Szerkeszt6)

g Translation Memories
(Forditasi memoériak)

IE
km*’ Alignment
(Szbvegszinkronizalas)
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Leiras

Ebben a nézetben:

e népszerli sugo videdkat és dokumentacidkat nyithat meg

e az SDL Trados Studio-val kapcsolatos hireket olvashat

e Uj projekteket hozhat létre

e  0nallé dokumentumokat fordithat

e projektcsomagokat nyithat meg

e GroupShare projekteket nyithat meg

o hozzaférhet SDL Language Cloud fiokjahoz és kezelheti
Language Cloud gépi forditémotorokra térténé
eléfizetéseit

Barmely parancsra is kattint ezek kézll, az a megfelel6 nézetre
valt az SDL Trados Studio-n belll vagy megnyit egy masik
alkalmazast, ahol az adott miiveletet elvégezheti.

Itt tekintheti meg és dolgozhat a projektekkel. Kivalaszthat egy projektet.
A kivalasztott projektre és annak fajljaira vonatkoz6 informaciokat
részleteiben is megtekintheti. Ezen kivil nyomon kdvetheti a projekt

és a projektfajlok allapotat.

Itt dolgozhat a projekt fajljaival. Innen:
¢ nyithat meg fajlokat forditasra;

e nyithat meg fajlokat ellenérzésre;

o kotegelt miveleteket hajthat végre fajlokon;

e tovabba megtekintheti ezeknek a fajloknak a sz6szamat
és forditasi elérehaladasukat.

Itt tekintheti meg a projektjelentéseket. A jelentések részletes
forditaselemzési adatokkal szolgalnak, melyek kdzvetlendl a
projekttervezésben és a koltségvetés-készités folyamataban jatszanak
szerepet.

Itt torténik a dokumentumok leforditasa és ellenérzése.

Itt hozhat Iétre és kezelhet forditasi memodriakat.

Itt szinkronizalhatja korabban leforditott dokumentumait, hogy forditasi
memoria tartalmakat hozzon létre.

Ez a nézet csak akkor all rendelkezésre, ha egy szdvegszinkronizalas
eredményeképpen kapott fajlt (*.sdlalign) nyit meg.

Dokumentumok forditasa és ellen6rzése — Els6 1épések utmutatod
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SDLS
Munkafolyamatok

Tobb munkafolyamat kozil valaszthat az SDLTrados Studio-ban. Ezek olyan munkafolyamatok,
melyeket sajat igényeinek megfeleléen iranyithat és alakithat. A jelen utmutatéban a kovetkezé

munkafolyamatokat ismertetjik:

o Egyedilallo fajl forditasa
e Projektcsomag forditasa
MEGJEGYZES A GroupShare Project szerver segitségével végzett on-line

munkafolyamatokrél az SDL Trados Studio sugé vidediban és leirasaiban
talal informéaciét.

Egyediilallé fajl forditasi munkafolyamat
A kovetkez6 diagram az egyedulallo fajl forditasi munkafolyamat egyik lehetséges forditasi modjat

mutatja be.

[ Fordité

Beallitasok és
ergforrasok
megadéasa
(File >
Options)

Fajl
megnyitasa

Fajl leforditasa

Javitasra
van szilkség

Fajl
ellendrzése

Celnyelvii
dokumentum
létrehozasa

Dokumentumok forditasa és ellenérzése — Elsé |épések Utmutatd
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Projektcsomag forditasi munkafolyamat

A kovetkez6 diagram a projekicsomag forditasi munkafolyamat egyik lehetséges forditasi maédjat
mutatja be.

Projektvezeto

|

Beallitasok és
eréforrasok
megadéasa
(File >
Options)

Fajlok

véglegesitése

1

Projekt
letrehozasa

I

Projekicsomag Projoktcsomag
létrehozésa megnyitasa

|
|

Projektcsomag Visszakuldendd
kikuldese csomag elkildésa
1

Fordité ki

-

Visszeklldendd
csomag
letrehozasa

Projektcsomag
megnyitasa

1

Fajlok
forditésa

1

> Projektcsomag Projektcsomag
létrehozasa megnyitasa
R 24
\.
Projektcsomag Visszakuldendd
kikuldése csomag elkildése
| =
visszauTasiTva:f Lektor
Visszakilive
a forditonak javitasra . - o
Projektcsomag Visszakuldendd
megnyitasa okl
any lelrehozasa
Fajlok L JOVAHAGYVA
I lektoralasa
\ W,

Dokumentumok forditasa és ellenérzése — Elsé |épések Utmutatd
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Alapértelmezett nyelvpar-beallitasok

Adott forrasnyelvrdl adott célnyelvre t6rténd forditas esetén azok beallitasait nyelvparok (language
pair) taroljak. Az eréforrasok és opciok ugy lettek kialakitva, hogy az 6sszes olyan nyelvpar
esetében alkalmazhatdk legyenek, melyekre vonatkoznak. A tébbnyelvi eréforrasok, mint a
terminolégiai adatbazisok és a szerveralapu forditasi memoriak tébb nyelvparra is vonatkozhatnak.
A kétnyelvii eréforrasok, mint a fajlalapua forditasi memdriak, csak egy adott nyelvparra
vonatkoznak.

Még a dokumentumok forditasa elétt allitsa be ezeket az alapértelmezett beallitadsokat.

Ezaltal minden egyes forditashoz ugyanazokat a beallitasokat és er6forrdsokat alkalmazhatja.
Példaul angolrél németre torténd forditas esetén meghatarozhatja, hogy melyik forditasi memoriat,
terminolégiai adatbazist és milyen egyéb eréforrasokat kivan hasznaini.

Options (Beallitasok) parbeszédablak

Az Options (Beallitasok) parbeszédablakban hatarozhatja meg az alapértelmezett beallitasokat.
Ha uj forditasba kezd, az alapértelmezett forditasi memoriak és terminoldgiai adatbazisok
automatikusan megnyilnak, és az alapértelmezett beallitasok is érvénybe lépnek.

Nyelvpar-beallitasok

Altalaban az All Language Pairs (Osszes nyelvpar) szinten allithatja be a forditasi eréforrasokat
(még ha kétnyelviiek is), és ugyanitt modosithatja a beallitasokat. A beallitasok igy minden
nyelvparra, a forditasi eréforrasok pedig az 6sszes relevans nyelvparra vonatkoznak.

Példaul:

e Haaz All Language Pairs (Osszes nyelvpar) szinten olyan tébbnyelvi, szerveralapu
forditasi memoariat valaszt, amely tartalmazza az angol-német és angol-francia
nyelvparokat, akkor ez a forditasi memaria mindkét nyelvpar esetén alkalmazhato.

e Haaz All Language Pairs (Osszes nyelvpar) szinten 65%-ra médositja a minimum
egyezési értéket, akkor az minden nyelvparra érvényes lesz.

(bTipp Minden egyes nyelvpar bedllitasaihoz adhat egyéni kivételeket. Példaul,
ha meg akarja valtoztatni az angol-német nyelvpar minimum egyezési értékét,
akkor azt az adott nyelvpar szintjén teheti meg.

Option: E=SjEen )
0 SsSzes b g Editor Language Pairs
2 b- & This page lists the available language pairs. Mavigate to one of the language pair sub-nodes to modify
n ye 1 Vp ar b E—‘t File @ its settings. or use the Add and Remove buttons to add or remove language pairs.

\ b-[EL Em English (United States)->German (Germany)
4

_ English (United States)-=Japanese (Japan)
P2 Translation Quality Assessment

[E Language Pairs | I
4-=3 All Language Pairs
b - Bl Translation Memory and Automated Tran

Egyéni
nyelvparok
—

b= English (Un
b-=3 English (Un

STaUIL 185K Dequel

SUTT 155
Translation Memories View

T e

Dokumentumok forditasa és ellen6rzése — Els6 1épések utmutatd

9. oldal


http://shefftfs01.development.sheffield.sdl.corp:82/SDL%20Trados%20Studio/client_en/Edit_View/TMs/EVWorkingwithTMsAbout_Translation_Memory_Matches.htm#FuzzyMatchThreshold

Eroforrasok
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A kovetkez6 erdforrasok kozill valaszthat:

Eréforras Leiras
Az SDL Trados Studio fajlalapu forditdsi memaria fajlformatuma az .sdltm.
Hasznalhat SDL Trados Studio 2009, 2011 és 2014 barmely verzidjaban létrehozott
forditasi memoriakat egyarant. Ha korabbi SDL Trados vagy SDLX verziéban
Forditasi !étreho’zolt’t forditasi memoriaval rendelkezik, al_<ko’r g’zok’ra vona’tkozé tqvébbi
memoériak informaciét az SDL Trados Studio 2015 adatnjlglr’amos utmutatéban talal. Ott

Szerveralapu forditasi memoriakhoz is kapcsolédhat az SDL TM Server 2009 SP3,
2011 vagy 2014 és az SDL WorldServer 10.1-0.4 szerververzidékon keresztul.

Automatizalt
(gepi)
forditasi
szerver

Az automatizalt (gépi) forditas olyan forditast takar, amelyet emberi beavatkozas
nélkll, szamitdgépes szoftver végez. Az automatizalt forditast biztositoé alkalmazas
egy szerverre van telepitve, melyhez a szerveralapu forditasi memaériahoz hasonléan
férhet hozza. A kdvetkez6 automatizalt forditasi szerverekhez férhet hozza:

e SDL Language Cloud
e az SDL alapértelmezett automatizalt forditasi szervere
e SDL BeGlobal Enterprise

e Google Translate

Tovabba hozzaadhatja sajat testreszabott automatizalt forditasi szerverét is.

Terminoloégiai
adatbazisok

Az SDL Trados Studio 2015, az SDL MultiTerm 2009, 2011 és 2014-ben létrehozott
(.sdltb kiterjesztés() fajl-alapu terminoldgiai adatbazisokat haszndl. Tovabba a
kovetkezd kordbbi terminolégiai adatbazis formatumokat hasznalhatja:

e SDL MultiTerm 2007 (7.5 verzid) és régebbi 7.x kiadasok
e SDL MultiTerm iX (6.x verzid).

Ha megnyitja a régebbi verzidju terminoldgiai adatbazisokat, azok automatikusan
frissilnek SDL MultiTerm 2015 (.sdltb) formatumma. A MultiTerm Server 2009 SP3,
a MultiTerm Server 2011 és a MultiTerm Server 2014 verzion keresztul is
csatlakozhat szerveralapu terminoldgiai adatbazisokhoz.

AutoSuggest
szotarak

Az AutoSuggest funkcio egy fontos elem, amely felgyorsithatja a manualis forditast.
Az AutoSuggest funkcio figyelemmel kiséri az On éltal begépelt szavakat és néhany
karakter begépelése utan a forditasi memoriabdl olyan szavakat, mondatokat javasol
célnyelven, melyek ugyanazokkal a karakterekkel kezdédnek. A kdvetkezéket
hasznalhatja az AutoSuggest er6forrasaként:

e AutoSuggest szétarak — hozzon létre egy Ujat vagy valasszon ki egy korabbi
AutoSuggest szétarat, melyet On vagy egy masik felhasznald hozott Iétre.
Ez a szétar forditasi memoériakbdl (.sditm) vagy .tmx fajlokbdl kivonatolt
szavakat és mondatokat tartalmaz.

e A projekthez hozzarendelt SDL MultiTerm terminoldgiai adatbazis.

e AutoText bejegyzések — az SDL Trados Studio-ba valé begépeléssel sajat
kezlleg is létrehozhat egy sz6- és mondatlistat.

Dokumentumok forditasa és ellen6rzése — Els6 1épések utmutatod
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Az alapértelmezett nyelvpar-beallitasok meghatarozasa

Az angol (egyesilt allamokbeli) német (németorszagi) nyelvkombinaciéju forditasi projekt
esetében az alapértelmezett forditdsi memoriak, terminoldgiai adatbazisok és AutoSuggest
szoétarak beallitasahoz kdvesse az alabbi utasitdsokat.

MEGJEGYZES Ezeket a beallitasokat az All Language Pairs (Osszes nyelvpar)
szint megfelel6 helyén kell elvégezni.

Egyéb nyelvparok alapértelmezett eréforrasainak beallitdsahoz ugyanezt az eljarast kdvetheti.
Ebben a példaban az SDL Trados Studio mintaprojektjét fogja hasznalni. Ha mar otthonosan
mozog a lépések kdzott, akkor arra hasznalhatja azokat, hogy meghatarozza sajat alapértelmezett
eréforrasait, amelyek az On éltal alkalmazott valamennyi nyelvparra vonatkoznak majd.

1. A szalagmeniin valassza a File > Options (F3ajl > Beallitasok) menipontot.
Az Options (Beallitasok) parbeszédablak jelenik meg.

2. Valassza ki a Language Pairs > All Language Pairs > Translation Memory and
Automated Translation (Nyelvparok > Osszes nyelvpar > Forditasi memoria és automatizalt
forditas) szintet a navigacios savban.

3. A Translation Memory and Automated Translation (Forditasi memaria és automatizalt
forditas) oldalon valaszthatja ki a fajlalapu és szerveralapu forditasi memoriakat.
Valassza ki az English-German.sdltm minta forditasi memoriat.

% i ...Documents\Studio 2015\Projects\Samples\SampleProject\
TMs\English-German.sdItm

e Ha a program az angol (egyesililt &llamokbeli) - német (németorszéagi) nyelvpéarra
vonatkozdan nem tartalmaz alapértelmezett beallitasokat, akkor az Add Supported
Language Pairs (Tamogatott nyelvparok hozzaadasa) parbeszédablak jelenik meg.
Pipalja be az uj nyelvpar elétti jeloldnégyzetet, majd kattintson az OK gombra.

P o]

Add Language Pair @

Specify the source and target language of the new language pair:

Source Language: =] Englizh [United States) -

Target Language: E German [Germany] -

[ k. ][ Cancel ][ Help

Dokumentumok forditasa és ellen6rzése — Els6 1épések utmutatd
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4. Valassza ki a Language Pairs > All Language Pairs > Termbases
(Nyelvparok > Osszes nyelvpar > Terminoldgiai adatbazisok) opciét a navigacios savban.

5. A Termbases (Terminoldgiai adatbazisok) oldalon valaszthatja ki az SDL MultiTerm
terminolégiai adatbazisokat. Valassza ki a Printer.sdltb minta terminolégiai adatbazist.

% i ...Documents\Studio 2015\Projects\Samples\SampleProject\ Termbase\Printer.sdltb
O

optons R

b Editar Tembases
b [ AutaSuggest
E File Types
[E} Embedded Content Processors Termbaszes:
Werfication
3 Translation Quality Assessment
E Language Pairs
4-=% ol Language Pairz
b B Translation Memory and dutomated Tran
y
Search Seftings
p- 5% Batch Processing
b= Englizh [United Statez]->Japanese [Japan]
L5 Default Task Sequence
B Translation Memnories Yiew [ Add.. ] [ Remove
55 Colors

ﬁ Add termbases to the project and order them. Set a default termbase and check the language mapping.

Enabled Tembase Filter
7 Printer Termbase [defauk) @ [Mat specified)

AV v

F.epboard Shortcuts

. Languages:
& Automatic Updates

Froject Language “ Tembasze Language
E= English (Urited States) English
[®] Japanese [Japan) Japarese

v T "

@ welcome Wiew

) (o) [

6. Valassza ki a Language Pairs > English (United States)->German (Germany) >
AutoSuggest Dictionaries (nyelvpar > angol (egyesult allamokbeli)-német (németorszagi) >
AutoSuggest szotarak) opcidt a navigacios savban.

MEGJEGYZES AutoSuggest szbtarakat csak az egyéni nyelvpar szinteken allithat be.

Dokumentumok forditasa és ellen6rzése — Els6 1épések utmutatd
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Az AutoSuggest Dictionaries (AutoSuggest szotarak) oldalon valaszthatja ki az
AutoSuggest szotarakat. Valassza ki az AutoSuggest EN-US_DE-DE.bpm minta

AutoSuggest szotart.

...Documents\Studio 2015\Projects\Samples\SampleProject\

AutoSuggest\AutoSuggest. EN-US_DE-DE.bpm

Options

b Editor
b @ AutoSugoest
b E:', File Types
b [EL Embedded Content Processors
3 Werification
b |2 Tranglation Quality Assessment
4@ Language Pairs
b= &l Language Pairs
b= Englizh [United States)->Japaneze [Japan]
4-=% Englizh [United States]»Geman [Gemarny]
b £ Translation Memory and Automated Tran
b L% Batch Processing
b 4% Default Task Sequence
b Translation Memories Yiew
b :';_5_'_' Colars
) Keyboard Shortcuts
b G Automatic Updates
by Weloome Wiew

AutaSuggest Dictionaries

This page lists the dutoSuggest dictionaries. se the Add and Remove buttons to add and remove
AutoSuggest dictionaries. Uze the Generate button to generate AutoSuggest dictionaries.

[F=5 OB =

§ AutoSuggest EN-US DE-DE

[ Add ][ Remove ]

ak. ][ Cancel ][ Help ]

8.

Az alapértelmezett beallitasok elmentéséhez kattintson az OK gombra.

Ezek utan, amikor angolrél németre fordit, akkor a program ezeket az er6forrasokat hasznalja
majd.

(DTipp
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Az All Language Pairs (Osszes nyelvpar) rész alatt tovabbi beallitasokat adhat
meg, mint példaul a minimum részleges egyezés (fuzzy match) értékeket és az

automatikus helyettesitést. Ne felejtse el, hogy ezek a beallitasok az 6sszes
nyelvparra vonatkoznak majd. Ha csak az angol-német nyelvparra vonatkozé
beéllitasokat szeretné megadni, akkor azt a Language Pairs > English
(United States) -> German (Germany) rész alatt teheti meg.
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Forditas az SDL Trados Studio-ban
Fajl megnyitasa forditasra

Az SDL Trados Studio-ban kétféle médon nyithat meg fajlokat forditasra. Az egyik médszer az
egyedulallé fajl forditasa, mig a masik a fajl projektbél vagy projektcsomagbdl valé megnyitasa.

A megnyitas modja Leiras
A Files nézet Home flilén kattintson az Open For Translation gombra
Egyediilallé fajl vagy barmelyik nézetben valassza a Files > Open > Translate Single
megnyitasa forditasra Document (Fajl > Megnyitas > Egyedilalld dokumentum forditasa)
opciot.

A Files (Fajlok) nézetben jobb egérgombbal kattintson a fajlnévre,
majd valassza az Open for Translation (Megnyitas forditasra)

Fajl megnyitasa parancsot.

projektbdl vagy
projektcsomagbdl

o A csomaghoz hozzarendelt forditasi memoriak, terminoldgiai
forditasra

adatbazisok, AutoSuggest szétarak és beallitasok automatikusan
megnyilnak.

Dokumentumok forditasa és ellenérzése — Elsé |épések Utmutatd
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Egyedulallo fajl megnyitasa forditasra

2.

Tegytk fel, hogy a SamplePhotoPrinter.doc fajlt angolrdl (egyesiilt allamokbeli) németre
(németorszagi) kivanja forditani. A fajl megnyitasahoz és az Options (Beallitasok)
parbeszédablakban elézetesen meghatarozott beallitasok elfogadasahoz kévesse az alabbi
utasitasokat.

1. Valassza a File > Open > Translate Single Document (Fajl > Megnyitas > Egyedulallé

dokumentum forditasa) opciot. Az Open Document (Dokumentum megnyitasa)
parbeszédablak jelenik meg.

l i ...Documents\Studio 2015\Projects\Samples\SampleProject\
en-US\SamplePhotoPrinter.doc

P

u Dpen Docurment
Lockin: 1) en-US - @' ? ¥ '
= Marme :
e M| SamplePhotoPrinter.doc
Feeei? Plees SamplePhotoPrinter.doc.sdlliff
- [ SamplePresentation.ppt:
E SamplePresentation, pptesdl=liff
Desktap M= SecandSample.doc
o secondiample.docxsdldiff
I_u;l!»J M| TryPerfecthatch.doc
Libraries TryPerfectbdatch.doc.sdl«diff
1V
Caormputer
"‘:Ia.
u 4 | 1] k
Metiork
File narne: A
Files of type: [.ﬁ.ll file [*.7] '] [ Cancel ]
Encoding: | (Buto-select] -|

Valassza ki a mintafajlt, majd kattintson az Open (Megnyitas) gombra. Az Open Document
(Dokumentum megnyitasa) parbeszédablak jelenik meg.

Dokumentumok forditasa és ellenérzése — Elsé |épések Utmutatd
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Dpen Docurment @

Source Language: =] English [United States) -

Target Language: [ German (Gemary)  [optional]

Tranzlation Memary and Automated Translation

Select tranzlation memaory and automated tranzlation servers and specify whether o include them in lookup,
ﬂ concordance zearch and whether o update them.

of Add - G Create - | T Settings.., | | 3 Rernowe | § Import. § Export.
M arme Enabled Lookup Penalty Concordance Update
B Sample Project_Englizh-German.zdltm ¥ # 0 ¥ ¥

| Do rot shaw thiz dialog again if the language pair settings for the document are known.

Advanced... [ 0k, l| Cancel || Help |

Az el6z6leg kivalasztott forditasi memoria automatikusan megjelenik a Translation Memory and
Automated Translation (Forditasi memoria és automatizalt forditas) részben.

@Tipp A halado beallitasok meghatarozasahoz kattintson az Advanced (Halado)
gombra. Ez az Options (Beallitasok) parbeszédablakban kivalasztott
terminoldgiai adatbazist és AutoSuggest szoétarat is megjeleniti. Valamint egyéb, a
forditashoz hasznalt eréforrasokhoz kapcsolddo beallitasok is megjelennek
(példaul a minimum részleges egyezés érték, a TM frissitésekor hasznalando
metaadatok és a konkordanciakeresés beallitasai).

3. Kattintson az OK gombra:

e A forrasnyelvi dokumentum fordithaté tartalma egy kétnyelvii SDLXLIFF fajlban kerdl
azonositasra, szegmentalasra és elhelyezésre. A program a fajlt az Editor nézet
Editor (szerkesztd) ablakaban nyitja meg.

e Az alapértelmezett forditasi memoriakat, terminolégiai adatbazisokat és AutoSuggest
szotarakat, melyeket korabban adott meg, a program automatikusan megnyitja.
Az Options (Bedllitasok) parbeszédablakban megadott minden egyéb beallitas szintén
automatikusan megnyilik.

4. Kattintson a b Save Document (Dokumentum mentése) gombra a
Gyorselérési eszkdztaron vagy valassza a File > Save (F3jl > Mentés) opcitt:

e A Save as (Mentés masként) parbeszédablak jelenik meg. Mentse el dokumentumat
SamplePhotoPrinter.doc_en-US_de-DE.sdlxliff néven. Kattintson a Save (Mentés)
gombra, ha ezzel a névvel kivanja elmenteni dokumentumat.

e Egy ugyanilyen nevi projekt automatikusan Iétrejon: SamplePhotoPrinter.doc_en-
US_de-DE.

Dokumentumok forditasa és ellen6rzése — Els6 1épések utmutatod
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Projektbeallitasok modositasa

A Project Settings (Projektbeallitasok) parbeszédablakban moédosithatja a beallitasokat, miutan
mar megnyitotta a fajlt. Amikor megvaltoztatja a projektbeallitasokat, akkor altalaban az

All Language Pairs (Osszes nyelvpar) szintjén 1évé bedllitasok is mdodosulnak, éppugy,

mint amikor az Options (Opcidk) parbeszédablakban meghatarozta az alapbeallitasokat.

Tegyuk fel, hogy a részleges egyezés (fuzzy match) minimum egyezési értékét 65%-ra szeretné
allitani. Ez a forrasnyelvi dokumentum szegmensei és a forditasi memoaria szegmensei kozotti
egyezés minimum értéke. A megadott érték alatt a program nem jeleniti meg az egyezéseket.
Az alapértelmezett érték 70%.

A minimum érték modositasahoz:

1. A Translation Results (Forditasi eredmények) ablakban kattintson a Project Settings
(Projektbeallitasok) gombra.

QR 9-2-Q - 3D0L Trados Studio - Sample Project - 0O
Home Rewieuy Aikvanced Wi Add-Ing Help
,:;Cutab;u’ - - - o e £ Jﬂ #8 g > @T
Y7 @ cony e A eom. ma ‘Y »a )
Project _ Batch Clear Concordance Confirm Go
Settings g Paste Tasks+ M T 9T Formatting ~ w'ow Search~ b - wi LT Toe
Configu.. | Clipboard | File Acti.., Formatting QuickInsert G| Translation Me., & 0T W | Segment Actions & | Mavigation
EﬁO\ ¢ | @ English-German - Translation Resultz «| 1 ¥ || Term Recognition - 3
g] SamplePhataPrinter. doc. sdixfi = E‘ we ProjectSettings |F. . B > @ o ﬁ_l
4+ Erste Schiitte g el =S taTeEy ':D Mo results available.
i disfGesigneten Aufstdsart flir lhe “%
b Connecting and buming enthe e | 21 gatting Started Erste Schritte
g] SamplePhotoPrinter.doc [Translatio T1 4 m -
- Erste Schritte
i disfGesigneten Aufstdsart flir lhe
b Connecting and turning an the p
g] SamplePhotoPrinter.doc. sdl=liff [Tra
>
Englizh-German 8/27/200812:21:41 PM  STUTTGART\dbrockmann
F ErnglishGerm ... | 8 English-Gem.. B Commerts(0] 3 TQ4s(0] S Messages (1] |0 Tem Recogrition 3 Tembaze Seac
SamplePhotoPrinter doc. sdiliff [Translaion]  SamplePhotoPrinterdoc [Translation en-US-de-DE] | SamplePhotoPrinter. doc.ec 4 b | 7
1 Getting Started «E  Epste Schritte B
Finding a location for your ¢ dfsfGeeigneten
"""""" 2 photo printer Aufstellungdsort fiir
@ Wwelcome Thren Fotodrucker finden
. Place the photo printer on a flat, clean and O LI
wy Projects 3 dust-free surface, in a dry location, and out
B of giract suright
Files 4 Allow at least 12 cm clearance from the back 4, dejwle L1
I of the photo printer for the paper to travel,
E Reports When connecting power or USB cables, kesp [
i 5 the cables clear of the paper path to the front
& Editor and rear of the photo printer.
i i Far proper M LI
g Translation Memories vertilation

A Translation Memory and Automated Translation (Forditasi memoria és automatizalt forditas)
oldalon belil az All Language Pairs (Osszes nyelvpar) rész alatt jelenik meg a Project Settings
(Projektbedllitasok) ablak.

Dokumentumok forditasa és ellenérzése — Elsé |épések Utmutatd
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Valassza ki a Language Pairs > All Language Pairs > Search (Nyelvparok >

Osszes nyelvpar > Keresés) meniipontot a navigacios savban.

Minimum
részleges
egyezés
érték
Project Settings - Sample Project EIIEI
b wg Project Leomalat
» - [E} File Typss Mirirnurn match value: 0
b [E} Embedded Content Processors - -
- Maximurn number of hits: 1=
3 Werification
b2 Translation Quality Assessment [ Search for fuzzy matches even if exact match found
Keresés 4@ Language Fairs [ Search bath project and main translation memaries
d-= AL Pai . .
oldal \ anguagx.a b [7] Look up segments in MT even if a TM match has been found
Tranzlation Memory and Autormated Tran
[ [Search| |
Penalties Concordance
Filters Minimum match value: i
Update
Language Resources b axirnum number of hits: 30+
b (G Termbases
] ‘ﬁ; Batch Processing Search Optionis
b= Englizh [United States)->German [Germany) Show moszt recent translations first
b= Englizh [United States)->French [France) R . . .
: i Using multiple translation providers:
b= Englizh [United States)->Japanese [Japan) ]
@ Show best matches from all providers
(7 Only show matches from first provider that retumns matches
Reset to Defaults [ u] ] [ Cancel ] [ Help

®Tipp

A Translation (Forditas) rész alatt allitsa a Minimum match value-t (minimum egyezési

értéket) 70-re.

Az OK gombra kattintva fogadhatja el az éppen megnyitott dokumentumra vonatkozé keresési

beallitasokat.

Dokumentumok forditasa és ellen6rzése — Els6 1épések utmutatd
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Fajl megnyitasa projektbdl vagy projektcsomagbdl

Tegyuk fel, hogy projektcsomagot kapott tgyfelétdl, amely a forditasra vagy ellen6érzésre varé
fajlokat tartalmazza. A csomag megnyitdsahoz és tartalmanak forditasahoz kévesse az alabbi
[épéseket:

Projektcsomag megnyitasa

1. Vaélassza a File > Open > Open Package (Fajl > Megnyitas > Csomag megnyitasa)
opcidt. Az Open Package (Csomag megnyitasa) parbeszédablak jelenik meg.

ﬁiﬂ Ha folytatni kivanja a feladat ezen részét, akkor kérjen meg egy masik
SDL Trados Studio felhasznal6t, hogy hozzon létre egy projektcsomagot,
amelyet On az SDL Trados Studio-ban megnyithat.

2. Valassza ki a projektcsomagot, amelyet meg szeretne nyitni, majd kattintson az
Open (Megnyitas) gombra. Az Open Package (Csomag megnyitasa) varazslé
Review Package Contents (Csomag tartalmanak attekintése) oldala jelenik meg.

Open Package

b = s
Review Package Contents EQ

Fieview the package contents and click Finizh to start importing the package.

Package type [FiE=05
Project Sample Project Files 4
Task Tranglate Total words 2912
Due date [none] Untranzlated words 2670
Azzigned by  Catalina Adam Unreviewed words 2672
Asszigned to  pghnb
Customer [none)
Comment
e Translate Wiew File.. %0 Include Subfolders
L Mame Wards Status Progress Reference File £
= El__] S amplePrezentation pptx. sdlxl.. 9 In Translat... . 22% Oa
B[] SamplexL_DITA il sl 2491 Unzpecified O
B (i SecondSample. dock sdiiff 183 InTranslat. ] 12% O
= Iﬂ__] TryPerfectM atch. doc. sdllitf 224 In Translat.. 97 O
'l I 3
< Back Mext > [ Finish J [ Cancel ]

3. A csomag importalasahoz kattintson a Finish (Befejezés) gombra. Az Importing Package
(Csomag importalasa) oldal jelenik meg.

4. Amennyiben ez az els6 projektcsomag, amit megnyit a szoftverrel, a Studio alapértelmezetten
létrehoz egy projektmappat a Dokumentumok mappaban. A mappa neve megegyezik a
csomaghoz hozzarendelt projekt nevével. A Review Package Contents (Csomag
tartalmanak attekintése) ablak Browse (Tall6zas) gombjara kattintva médosithatja a projekt
mappajanak helyét.
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5. Ha az importalas befejez6détt, az Open Package (Csomag megnyitasa) varazslo
bezarasahoz kattintson a Close (Bezaras) gombra. Ezzel a program egy projektet hoz létre a
csomagban szerepl6 projekt részletei alapjan, és megnyitja azt.

Dokumentumok forditasa és ellenérzése — Elsé |épések Utmutatd
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Projektfajl megnyitasa

Az éppen megnyitott és a projektcsomaghoz rendelt projekt lesz az aktiv projekt. Most méar
megnyithatja a projektfajlokat forditasra.

g

o

Eme feladat kdvetéséhez hasznalja az alkalmazas Sample Project nevi fjjljat.
Ha nem ez az aktiv (éppen kivalasztott) projekt, akkor valtson a Projects
(Projektek) nézetre és kattintson kétszer a Sample Project sorra.

...Documents\Studio 2015\Projects\Samples\SampleProject\
Sample Project.sdlproj

1. AFiles (Fajlok) nézet megjelenéséhez kattintson a navigacios ablak Files (Fajlok)
gombjara. Ez a nézet megjeleniti a projekicsomag 6sszes fajljat.

Az aktiv projekt
neve megjelenik

a cimsorban:
Sample Project

Q-
Home Wi
vy 4
Project Open Far
Settings Translation

Configuration

Files

= erman (Germany)

Project folders
ww Sample Project

“V My Tasks

¥ Sent Tasks

Le{ b) Translate [to yghnbl

\I SOL Trados Studio - Sample Project I - 0

Add-Ins Help

o Dpen For Review a OB BB @ &1 || File details layout - Ap 'R
) | JE = = - = o
L Open For Sign-off B B3 B M [z it
=R ? Batch B & _' & & Create Project ! Goto last W‘f
Tasks= [G E ) o8 - Package seqrment iy
Open File Actions GroupShare Packages Layout Eookmarks
< Mame Words Statug Frogress Size Uzage File Type |den. Path
@] SamplePhotoPrinter.doc.zd... kN | 7 Open For Translation Translatable ‘wiord 2000-200. %
- Ils_lj SamplePresentation. ppt= 3 Transzlatable PowerPoint 200.. %
[3] SamplexML_DITA.kml 2497 % = Translatable ML DITA 1 v N
W Secondsample.dock 183 'L Open For Sign-off Translatable Wword 2007 v 2.0, %
\El_] TryPerfectt atch. doc 224 Batch Tasks y | Translatable “whord 2000-200.. M

& Create Project Package
P& Create Studio 2009 Package

Explore Containing Folder

[@ Open File Yith

2. Kattintson kétszer a SamplePhotoPrinter.doc.sdlxliff fajlra. A fajl, a projekthez vagy a
projektcsomaghoz rendelt forditasi memdriakkal, terminolégiai adatbazisokkal és AutoSuggest
szoétarakkal egyutt automatikusan megnyilik az Editor (Szerkeszt) nézetben.

MEGJEGYZES

Ugyanezt megteheti, ha jobb egérgombbal az Open For Translation
(Megnyitas forditasra) fllre kattint a helyi mentben. Ezt szemlélteti a fenti
képernybkép is.
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Elsé pillantas az SDL Trados Studio forditasi kornyezetére

Az SDL Trados Studio-ban a dokumentumok ellenérzése és forditasa az Editor (Szerkeszt6)
nézetben torténik. Ez a nézet a kdvetkezbket tartalmazza:

o Navigacios ablak, ahol megtekintheti az 6sszes megnyitott dokumentumot és navigalhat
kozottik;

o A szerkesztéshez hasznalatos eszkdzOket tartalmazoé szalagmend flilek és csoportok;
e Szerkesztd ablak, ahol a tényleges forditas vagy ellenérzés torténik;

e Translation Results (Forditasi eredmények) ablak — ez az ablak jeleniti meg a forditasi
memoriaban végzett keresés eredményeit és az automatikus forditast. Ha nincs megelégedve a
program altal automatikusan generalt megoldassal, akkor ezekbdl a variaciokbdl valaszthatja ki az
aktualis szegmensnek megfelel6t.

e Term Recoghnition (terminoldgia felismerés) ablak — ez az ablak jeleniti meg a terminologiai
adatbéazisban végzett keresések eredmeényeit.

Translation Results Term Recognition
(Forditasi eredmények) (Terminoldgia felismerés)
ablak ablak
QR e-2-E = SDL Tfados Studio - Sample Project - g =
Home Review Advanced Wiew Add-Ins Hel
| o Cut #hiu . - - 0o e £ : | &E/)@ @1
Y7 & cony P ox o 4 ©® M «n & oL A, 4
Project - Batch Clear Concardance - Caonfir N Go 4
Settings B Paste  Tasks= M MO 9T Formatting = P Search = B - v L'
Configu., = Clipboard | File &cti.., = i Ll - L bl _Segrmient Actions m avigation 2
Editor ¢ \|E English-German - Translation Results ~| I 3 | [Term Recognition - 0 @:I
o % [E] e
SamplePhotoPrinter.doc. sdliff [Trans! I% we ProjectSettings  HL HL B ¥ ae @ 2
Erste Schiitte g Flace the photo printer on a flat, clean and dust-free surface, in a dry phato printer 2
- &
- disfGesigneten Aufstdsort fir [hren | location, and out of girect sunight Fotodrucker
b Connecting and turing on the powe % Place the phota printer on a Platzieren Sie den L 4]

SamplePhotoPrinter.doc [Translation en
Erste Schiitte

i disfGiesigneten Aufstdsort fiir lhien
b+ Connecting and tuming on the powe

flat, clean and dust-free Fotodrucker auf einer
surface, in a dry location, flachen, sauberen und
and gut o airect suright staubfreien

Oberflache, und stellen

n

SamplePhotoPrinter. doc. sdl=liff [Trans! 1 e
Getting Staed Sie ihn Pan ginam
+[Finding a lacation for your phota pri trockenen Ort auf, ad
b Connecting and tuming on the powe English-Geiman B/4/2015 12:19.05 AM GLDBAL\cadﬂl
B English-Gemm . | a3 EnglishGern. = Commentsil] % TOA: (1) S Messages (0] ﬁ Term Recognition a Temmbase Seaich
G e e e L e e e e e
1 Getting Sta rted @m Erd C\Users\dbrockmann\Documents\Studio 2011\P:|jact ¢
Finding a location for your # dfsfGeeigneten 1
------- 2 photo printer Aufstellungdsort fiir 1
& welcame Thren Fotodrucker finden
. Place the photo printer on & flat, clean and . Flatzieren Sie den Eofudoucker auf einer LT
wy Projects dust-free surface, in a dry location, and out flachen, saublren und staubfreien
B 3 of direct sulight, Oberfliche, und stellen Sie ihn an einem
Files trockenen Ort auf, der Asivem ciekten
I Sonmanictit ausgeseatztist,
E Reports 4 Allow atleast 12 cm clearance from the back ' LI
> . of the photo printer for the paper to ravel,
& Editor when connecting power or USB cables, kesp [
. . 5 the cables clear of the paper path to the front
g} Translation Memories and rear of the photo printer,
For proper O LI
ventilation L3
L_entidt

Y ol seanprts M5 (1 68.04% &7 2000% 11872 B Chae 182 3 07219 EE e

Editor (Szerkesztd)
ablak
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Az Editor (Szerkeszt6) ablak részletesebb megismerése

Az Editor nézet Editor ablaka az, ahol a dokumentumok forditasa térténik. A kétnyelvii SDLXLIFF
dokumentumban talalhaté forditand6 szveg és a forditas egyméas mellett jelennek meg.

A forrasnyelvi széveg az ablak bal oldalan, mig a célnyelvi szOveg az ablak jobb oldalan jelenik
meg. A dokumentumok tartalma szegmensekre bontott (altalaban mondatok). A célnyelvi
szegmensek szerkeszthetbek.

o Az els6 oszlop a szegmensek sorszamat jeldli. Beallithatja, hogy a program ne mutassa a
szegmensek sorszamat. A forras- és célnyelvi szegmensekkel két kiilonallo listaként is
dolgozhat.

o Aforras- és célnyelvi szegmensek oszlopai k6zott helyezkedik el a szegmensallapot
oszlop. Ez az oszlop nagyon fontos, hiszen ez mutatja az adott szegmens forditasi
allapotat és a forditas eredetét. Példaul mutatja, hogy a forditast jovahagyta és az adott
szegmensre 100%-os egyezést talalt a program a forditasi memoriaban.

o A célnyelvi szegmensektdl jobbra taldlhaté a dokumentum szerkezetét jeldl6 oszlop.
Egy kdddal jelzi, hogy az eredeti dokumentumban hol jelenik meg a szegmens szdvege.
Vigye a kurzort a kéd folé vagy kattintson a kédra és lathatja, hogy a forrasnyelvi
dokumentumban hol jelenik meg az adott szegmens.

Dokumentumnév fil Célnyelvi
Forrdsnyelvi szegmensek szegmensek

SamplePhotoPrinter. doc.sdislff [Tranzlation]  SardplePhotoPrinter.doc [Translation en-JS-de-DE] | SamplePhotoPrinterdoc.sg 4 [ » | ™

a

1 Getting Started #EM  Erste Schritte [P
Finding a location for your ~# dfsfGeeigneten
: photo printer AufsteHurgdsort fiir
Ihren Fotodrucker finden
Flace the photo printer on a flat, clean and & Platzieren Sie den Egfndrucker, auf einer
dust-free surface, in a dry location, and out flachien, sautbren Lind staubfreien
3 of direct surlight Oberflache, und stellen Sie hn an einem

trockeren Ort auf, der Kefwer Givaktarnr
Sonneniicht susgesetzt ist,
Allowe at least 12 cm clearance from the back & LI
of the photo printer for the paper to fravel,
YWhen connecting power ar USB cables, keep O
5 the cables clear of the paper path to the front
and rear of the photo printer,

Szegmensek Szegmens allapota Dokumentum szerkezete
sorszama
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A mintadokumentum forditasa SDL Trados Studio-ban

Ez a rész mutatja be azt, hogyan forditsa le a mintaprojekt SamplePhotoPrinter.doc nevii fajljat
németre az SDL Trados Studio-ban. El6sz0r is nyissa meg a mintafajlt. Részletekért Iasd a
Projektfajl megnyitédsa fejezetet.

l i SamplePhotoPrinter.doc.sdIxliff a Sample Project-ben

o ...Documents\Studio 2015\Projects\Samples\SampleProject\

Sample Project.sdlproj

Szovegkornyezeten alapulé egyezések (Context Matches)

1. Ha megnyitja a mintafajlt, akkor az elsé szegmensben automatikusan lefut egy keresés.
Az alabbi példa esetében:

e A forditasi memoriaban végrehaijtott keresés eredményei a Translation Results
(Forditasi eredmények) ablakban jelennek meg és a legjobb megoldast a program
automatikusan a célnyelvi szegmensbe helyezi.

e A program sztvegkdrnyezeten alapulé egyezést talalt a forditasi memériaban,
amit automatikusan jovahagyott. Az egyezés tipusa [ cv P szegmensallapot

oszlopban jelenik meg, és a ﬁf szimbodlum jelzi, hogy a szegmenst jovahagytak.

A szdvegkornyezeten alapul6 egyezés nem mas, mint 100%-os egyezés kontextusba
agyazva. Példaul az adott mondatot megel6z6 mondat is ugyanaz a forditasi
memoriaban, mint a dokumentumban. Ebben az esetben a szévegkérnyezeten alapuld
egyezés azt jelenti, hogy ezt a mondatot a dokumentum elején mar egyszer leforditottak.
A program feltételezi, hogy a forditasi memaria és a példa (ahol ez az elsé mondatpar)
kontextusa megegyezik. A szbvegkornyezet alapu egyezést nem kell szerkeszteni.

Dokumentumok forditasa és ellenérzése — Elsé |épések Utmutatd
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QH e-2 = SDL Trados Studio - Sample Project - O
Haorne Rewviews Advanced Wiew Add-Tns Help

Translation = Cut m b 7/ u o4 - - - -0« £ @% B @ 4y > @ t
Results N B Copy x* X la © ® ™ «» 4 ) ) » ¥

Project Batch Clear Concordance Confirm . Go v
(Forditési \ Settings Paste Tasks= M T 9T Farrmatting = womn Search = = - T Tor =
eredmények) nfigu... | Clipboard | File &cti.., Farmatting Quicklnsert G Translztion Me., & T & Segrment Sctions & | Mavigation
ablak Edito ¢ | [E ||Enalish-German - Translation Results ~| I x| |Thm Fecoanition -1 X

= . 2 = = S
E_|] SampleF‘hotoPhntﬂ doc. sdiHliff [Tra g wp Project Settings | Bp B B 4 @
4 Erste Schritte & || Getting Started ) Mo results avalable.
dizfGeeigneten AufztddEn Ihr 2
b C ting and turi t T "
onnecing andiuining on i |, Getting Started IEZM Erste Schiitte -

E_|] SamplePhotoPrinter doc [Translatio
- Erste Schritte
dizfGesigneten Aufstdsort flir lbr
b Connecting and tuming an the p
E_|] SamplePhotoPrinter. doc. sdidiff [Tra
.
Finding & location for your phato
b Connecting and tuming on the p

English-German 8/27/200812:21:41 PM STUTTGART dbrockmann
& EnglishGam.. | a2 EnglishGerm.. & Comments0] % TO&3(0) & Messages (0] |G Tam Recognition [F Tembase Search
SamplePhotoPrinter. doc. zdikiff [Tranglation]  SamplePhotoPrinter doc [Translation enddS-de-DE] | SamplePhotoPrinterdoc.ed 4 [ » |7 >

1 Getting Started
Finding a location for your
photo printer

m

=

Ihren Fotodrucker finden

-a) Welcome
. Place the photo printer on a flat, clean and & Platzieren Sie den Egtndrucker, auf einer [ — Szeqgmens

wy Projects dust-free surface, in a dry location, and out flachen, sauberen und staubfreien / g
B - 3 of direct surlight Cberflache, und stellen Sie hn an einem allapota
= Files trockenen Ort auf, der keiem diraktar oszlop
I Sorenichit ausgeseatzt ist,
E Reports 4 Allow 3t least 12 cm clearance from the back LI

of the photo printer for the paper to travel.
& Editor When connecting power or USB cables, kesp [

5 the cables clear of the paper path to the front

g Translation Memories and rear of the phato printer.

Far proper 0O LI

ventilation -

YV allsegments NS [ 63043 & 2009% £ 1167% B Chas 14 3 04219

Részleges egyezések

2.

Helyezze a kurzort a 2. célnyelvi szegmensbe.

Két részleges egyezés (91% és 89%) taldlhato a forditasi memariaban,
melyek a Translation Results (Forditasi eredmények) ablakban jelennek meg.

A 91%-o0s talalat a legjobb, ezért azt a program automatikusan beilleszti a dokumentum

célnyelvi

®Tipp

szegmensébe.

A File > Options > Editor > Automation (Fajl > Beallitdsok > Szerkeszt6 >
Automatizalas) menipont alatt médosithatja a legjobb részleges egyezés
automatikus beillesztéséért felelds beallitast.
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.||English-German - Translation Results

wy Project Settings s Hy B 2
Road Safety Education in our Mational Schools

SDLS$

| I || Tem Recognition - 1
BEE

Y u
(1) Moresuls available.

Road Safety Education in our
918-0s 1

Prisralational Schools Grundzchule

Warkehrserziehung in der

egyezés —
Road Safety Education in our

Secondaryllational Schools

Sekundarstufe

Werkehrserziehung in der

; Foad Safety Education in our_

Werkehrserziehung an Schulen

/ Mational Schools
89%-o0s

) English-German
egyezés

8 English-Gem... |2 English-Gem.. & Comments[0) ¥ TOAs[0] & Messages (0]

SamplePhotoPrinter.doc [Translation en-J5-de-DE]

) Association for Road Safety
Conference

1/18/2000 31347 PM STUTTGARTSdbrockmann

3 Tem Recoonition | Tembase Sean

S amplePhaotoPrinter. doc. sdl=liff [Translation]® | SecondSample.docsedl:l| 4 | k| ™

Road Safety Education in our

National Schools |€
Fark Hotel, Dublin &, Ireland - Friday, May M
23, 2008
The Mational Association for Road Safety [
(MARS) invites all primary school teachers to
4| participate in a day long conference on Road
Safety education for four to eleven year old
children.
This conference presents the new education
programime unveiled by the Minister for
Education last year.
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Tagung der Gesellschaft A 91%-0s
fiir i i egyezés

n n t ti-
Verkehrserziehung in der iisﬁa )
E g0 (o= I g 10| [ elfogadva

Auf dieser Tagung wird das neue
Erzichungsprograrmm prasentiert,
welches letztes Jahr vam
Bildungsminister vorgestellt wurde.



Terminolégiai adatbazis egyezések

Abban a pillanatban, hogy a kurzorral a 2. szegmensbe kattintott, egy terminolégiai adatbazis
keresés is lefutott. A Photo printer kifejezés szerepel a terminoldgiai adatbazisban,
melyet a forrasnyelvi szegmensben piros fellilvonassal emelt ki a program.

photo printer

A Fotodrucker kifejezés forditasa a Term Recognition (Terminoldgia felismerés) ablakban jelenik
meg. Ez a forditas mar szerepelt a forditasi memariaban, ezért a program automatikusan a
célnyelvi szegmensbe helyezte azt.

MEGJEGYZES Egy terminusforditas beillesztéséhez nyomja meg a Ctrl+Shift+L
billentyllkombinaciét vagy valassza a Term Recognition
(Terminologia felismerés) ablakban az Insert term translation

(Terminusforditas beillesztése) E:;" parancsot vagy az Editor nézet
Home flilének Terminology csoportjaban nyomja meg a Show
Translated Terms (Leforditott terminusok megjelenitése) gombot.

Englizh-German - Translation Results | & ¥ || Term Recognition « & ¥ |Term
wy ProjectSettings 3, 3L B ¥ B 3 W] Recognition
(Terminolégia

Finding a location for wour photo printer phato printer felismerés)
Fatodrucker / ablak

photo printer Fotodrucker finden

Finding & location for your Xl ~urstellungsort fir lhren -|

English-German BA4/2015 1215058 Ak GLOBAL scadam

e

B English-Gem.. |8 English-Gem.. = Comments(0) |3 TQA:(0) S Messagex(0) |3 Tem Recogrition F Tembaze Search

SamplePhotoPrinter.doc [Translation endJS-de-DE] | SamplePhotoPrinter.doc.sdikiff [Translation]® | SecondSample.docxsdsl 4 | b | ™ %
Kiemelt . . m - |
ceminus 1 Getting Started % Erste Schritte ("]

jon for your ¢ dfsfGeeigneten
photo printer Aufstellungdsort fiir
Ihren Fotodrucker finden

[lax.]

m

red

Place the photo printer on a flat, clean and & Platzieren Sie den Eofndrucker auf einer L —
dust-free surface, in a dry location, and out flachien, sauberen und staubfreien
3| of direct suriight, Oberflache, und stellen Sie ihn an einem

Forditas szerkesztése

3. A kovetkezbre javitsa a 2. szegmens forditasat: Aufstellungsort fiir Ihren Fotodrucker finden.
Ennek végrehajtasahoz kattintson a célnyelvi szegmensbe. A szegmens szerkesztéséhez és
a Geeigneten sz torléséhez hasznalja a standard Windows szévegszerkeszt6 funkcidkat.
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Helyesirasi hibak

A helyesirasi hibakat a helytelenl irt szé alatt megjelené hullamos piros vonal jelzi.
A 2. szegmensben a Fotodrucker szé piros hullamos vonallal lett alahuzva.

Helyesirasi g Platzieren Sie der| Egmndoucker. alf einer

hiba flachen, sauberen THd SEUDTERN
Oherflache, und stellen Sie hn an einem
trockenen Ort auf, der bederm Sirekies
Sormenlichit susgeseizt ist,

4. Tegylk fel, hogy a Fotodrucker szé helyesirasat kivanja hasznalni ebben a forditasban.
Kattintson a jobb egérgombbal és valassza ki a helyi mentbél az Add to Dictionary
(Hozzaadas a szdtarhoz) parancsot. Ezutan a terminus beker(l az On sajat szétaraba és a
piros hullamos vonal eltlinik.

®Tipp Sajat szotaranak megtekintéséhez valassza a File > Options (Fajl > Beallitasok)
menun belil az Editor > Spelling (Szerkeszté > Helyesiras) opciot.

Forditas jovahagyasa

5. Miutan befejezte a 2. szegmens forditasat, annak jovahagyasahoz nyomja meg a
Ctrl+Enter billentylikombinaciot vagy kattintson az Editor nézet Home fllén talalhato

Confirm (Translated) (Forditas jévahagyasa) ;Q# gombra. Ez a forditas befejezését jelzi.
Forditas elfogadasakor:

e A szegmens allapota Translated-re (leforditottra) valtozik és a kdvetkezd ikon jelenik

meg a szegmensallapot oszlopban: ﬁf

e A program automatikusan hozzaadja a forditast a forditasi memariahoz. Ha projekt
forditasi memoriat hasznal, akkor a program a forditast nem a f6 forditasi memariaban,
hanem a projekt forditasi memaériaban menti el.

MEGJEGYZES  Tqyabbi informacidért lasd az SDL Trados Studio stigd
Forditasi memoria frissitése részét.
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Formazasi bilintetés

Amikor a legutolso Iépésnél jovahagyta a forditast, a kurzor automatikusan a kovetkezé,
még jovahagyasra varé szegmensre ugrott. A Home fil Confirm parancsaval a program a
kovetkezd szegmensre ugrik.

A 3. szegmensnél a program 98%-os egyezést talalt a forditasi memariaban. A forditasi
memoridban talalt széveg a helyes megoldas, de mivel a célnyelvi szegmensnek sajat formazasi
beallitasai vannak, melyek eltérnek a forditasi memaridban szereplé széveg beallitasaitdl,

ezért 2% buntetépontot kap a forditas.

6. A Translation Results (Forditasi eredmények) ablakban talalhaté = szimbdlum jelzi a
formazasi blntetéseket. A blntetés részleteinek megtekintéséhez vigye a kurzort a
szimboélum folé.

MEGJEGYZES Alapértelmezetten, az SDLTrados Studio beallitasai szerint a felismert
formazasi cimkék (pl: a példaban talalhaté félkovér és délt) rejtve
maradnak. Beillesztésnél a cimkék rejtve maradnak és a széveg az
Editor (szerkesztd) ablakban megjelenitett stilusban lesz formazva.

Flace the photo printer on a Flatzieren Sie den LI
flat, clean and dust-free B Fotodrucker auf einer

surface, in a dry locati Score: 99
f?ff:gﬁié Missing formatting penalty (-1%)
Oherflactfie, und stellen

Formé&zasi
blintetés
szimbdluma

ie ihn pran einem
trackenen Crtd auf,

Bliintetés
részleteil
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Formazas alkalmazasa

7. A 3. forrasnyelvi szegmens tartalmaz néhany félkdvér betlvel (in a dry location) és néhany
délt bettivel (directsunlight) irt részt. Az alabbi mdédszerek egyikével formazza meg a
forditasban szerepl6 szdveget:

1. moédszer

A sziikséges formazast a QuickPlace legordiild listabdl valaszthatja ki. Az agynevezett QuickPlace
lista lehetévé teszi, hogy gyorsan helyezzen at elemeket a forrasnyelvi szegmensbdl a célnyelvi
szegmensbe. Példaul formazastipusokat, szamokat, datumokat és egyéb felismert, behelyezhet6
elemeket. A felismert, behelyezhetd elemekrél tovabbi informacié a Behelyezhetd elem
beillesztése fejezetben talalhaté.

Formazas alkalmazasa a QuickPlace listabdl:

e Jeldlje ki a célnyelvi szegmensben az an einem trockenen Ort szOvegrészletet és
nyomja meg a Ctrl+,(vessz6) billentylkombinaciét. A célnyelvi szegmens alatt
megjelenik a formazasi beallitasokat tartalmazé QuickPlace legordiilé lista,
valamint a forrasnyelvi szegmensben a program arany szinnel jel6li azt a

szbvegrészletet, amely ugyanazt a formazasi beadllitast hasznalja. QuickPlace
legdrdiild
Place the photo printer on a flat, clean and dust-free & Platzieren Sie den Eotndrucker auf einer flachen, lista
3 surface, in a dry location, and out of direct suriight sauberen und staubfreien Oberflache, und stellen Si
ihn ENEETaEl otodruckersuf, der_sei Trakiarn
¢ [sample text)
Allowe at least 12 cm clearance from the back of the Va fsampie fexd)

photo printer for the paper o travel,

o Az els6 félkdver betltipussal szedett mintaszoveg kivalasztasahoz nyomja meg az
Enter vagy Tab billentyt.

(sample text)
(zampls faxg)

félkovér
mintaszdveg

e A fenti lépések megismétlésével alkalmazhatja a délt betlitipust a keinem direkten
Sonnenlicht szdvegrészletre. Ez alkalommal a ddlttel irt mintaszdveget valassza ki a
QuickPlace gordilélistabal.

2. modszer

Formazasi beallitasokat a Quickinsert (gyors beillesztés) csoportban is valaszthat. igy akkor is
alkalmazhat formazasi beallitdsokat forditasan, ha az a forrasnyelvi szegmensben nem is létezik.

e A célnyelvi szegmensben véalassza ki az an einem trockenen Ort szdvegrészletet,

majd kattintson a b gombra a Home fil QuicklInsert (gyors beillesztés) csoportjaban
vagy nyomja meg a Ctrl+B billentylikombinaciot.

e A célnyelvi szegmensben valassza ki a keinem direkten Sonnenlicht szévegrészletet,
majd kattintson a (] gombra a Home ful QuickInsert (gyors beillesztés) csoportjaban
vagy nyomja meg a Ctrl+1 billentylikombinciot.

8. Aforditas jévahagydsahoz nyomja meg a Ctrl+Enter billentylikombinaciot.

Ellen6rzés

AZ SDL Trados Studio olyan ellen6rzd eszkdzdket is tartalmaz, melyek hibakat és
kovetkezetlenségeket keresnek a leforditott szGvegben. A szegmens forditasanak jovahagyasaval
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az ellendrzés automatikusan lefut és a hibak a Messages (Uzenetek) ablakban jelennek meg.
Az SDL Trados Studio a kovetkezd ellendrzéseket képes elvégezni:

Ellen6rzés

Cimkeellenérzés

QA Check 3.0

Terminolégiaellenérzés

Leiras

A cimkeellenérzé modul 6sszehasonlitja a célnyelvi szbveg és az
eredeti forrasnyelvi széveg cimketartalmat, majd meghatarozza,
hogy van-e koztlk kilénbség.

A célnyelvi szdvegben végrehajtott médositasok elfogadhatodak,
feltéve, hogy a cimkék szintaxisa érintetlen marad, illetve hogy a
leforditott dokumentum visszakonvertalhaté az eredeti
formatumba

A cimkeellen6érzé modul segit abban, hogy csak elfogadhaté
valtoztatasokat hajtson végre. Az ellendrzés beallitasait minden
egyes fajltipusnal kilon kell meghatarozni.

A QA Checker 3.0 egy sor mindségbiztositd ellen6rzd funkciot
tartalmaz. Az ellenérz6 funkcidk a kdvetkezé csoportokra vannak
osztva: szegmens ellendrzés, kizarandd szegmensek, pontossag,
szamok,

regularis kifejezések, szodlista, kovetkezetlenségek,

védjegy ellendrzés és szegmenshossz ellenérzése.

A WorldServer 10.4 verziotol kezdédéen minden WorldServer
projektcsomag tartalmazza a WorldServerben beallitott QA
Checker profil konfiguraciokészletét is. Ezaltal a Studio biztosan
ugyanazokat a minéségbiztositasi beallitasokat hasznalja a
WorldServer projektcsomag valamennyi fajlja esetében.

A terminolégiaellendrzés soran a program ellenérzi, hogy az
aktualis dokumentum forditasanal az SDL MultiTerm terminoldgiai
adatbazisban szerepl6 célnyelvi terminusokat hasznalték-e.
Tovabba megvizsgélja, hogy nem hasznaltak-e tiltott
terminusokat.

9. Mivel a 4. szegmens esetében a program nem talal egyezést a forditasi memaoriaban, a
célnyelvi szegmens Uresen marad. A példa szemléltetésére a kdvetkez6 rossz szamot
tartalmazd, helytelen forditast irja be: Lassen Sie 11 cm Abstand., majd a forditas
jévahagyasahoz és az ellenérzés lefuttatdsdhoz nyomja meg a Ctrl+Enter

billentylikombinaciot.

SamplePhotoPrinter. doc.sdlxdiff [Translation]

Allow at least 12 cm clearance from the back of the [ ] | I -

[ ——————————
photo printer for the paper to travel.
When connecting power or USB cables, keep the

5 cables clear of the paper path to the front and rear

of the photo printer.
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e A program hibat észlelt és a szegmensallapot oszlopban a Q szimbdlum jelenik meg.
A hiba gyors magyarazatahoz vigye a kurzort a szimbolum folé.

Felismert
behelyezhetd Place the photo printer on a flat, clean and dust-free & Platzieren Sie den Eoftndrucker auf einer flachean,
elem 3 surface, in a dry location, and ouwt of direct surilight sauberen und staubfreien Oberflache, und stellen Sie
i an einem trockenen Ort auf, der ke diretten
Sonneniicht ausgesetzt ist, Hiba
Allow 3t Ieas,]_.2c m dearance from the back of the ) Lassen Sie 11cm Abstand, szimbdodlum
photo printer for e paper 1o travel. a szegmens-

When connecting power or LISE cables, keep the Achten Sie beim

der Stromversorgung allapot
oszlopban
A hiba arra utal, hogy a forrdsnyelvi szegmens egy szdmadata hianyzik a forditasban.

Az 6n forditasaban 11 cm szerepel a forrasnyelvi szegmensben szereplé 12 cm helyett.
10. A hiba részletes informacioiért:

e Kattintson a Messages (Uzenetek) fiilre, hogy megjelenitse a Messages (Uzenetek)

ablakot.
Messages Messages (1) | & % |} Term Recognition
(Gzenetek) % € LlErrors 0Warnings (1) 0 Maotes & o
ablak .
Severty  Message * Qrigin photo printer
[ x] tMeasurement iz mizzing in target segment or iz not properly . OA Checker 3.0 Fotodrucker
L Li
B EnaglishGeman - Tra.. ,.g English-Geman - Co.. = Commerts(0) % TRz (0] {3 Mezzages (1] | [ Term Recognition Ii\, Tembaze Se
SamplePhaotoPrinter. doc [Translation en-US-de-DE] | SamplePhotoPrinter doc.zdl«liff [Translation]” | SecondSarmple. docs, sdl«liff [Translation]”
Allow at least 12 cm clearance from the back of the &y & [Lassen Sie Llcm Abstand.
photo printer for the paper o ravel.

When connecting power or LUSB cables, keep the /4 100 Achten Sie beim Yerbinden der Strormyersorgung
5| cables clear of the paper path to the front and rear of bzw. des USB-Kabels darauf, dass die Kabel den
the photo printer. Papierpfad nicht behinderm.

e Jobb egérgombbal kattintson a hibatizenetre és valassza a Show Message Details...
(Uzenet részleteinek megjelenitése) opciot.
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Verification Message Details - QA Checker 3.0 =

Source Segment Content:

Allow at least 12 cm clearance from the back of the photo
printer for the paper to travel.

Target Segment Content:

Lassen Sie 11cm Abstand

lgnaore Al
Suggestions: > Message:

Measurement is missing in target segment oris not =

Problem Description:

Missing or incomectly localized measurement found .«
in target segment. Consider adapting the

A Problem Description (Probléma leirasa) ablak tovabbi részletekkel szolgal,
illetve megoldasokat javasol a hiba elharitasara.

e Az Editor (szerkeszt6) ablakba valo visszatéréshez kattintson a Close (Bezaras)
gombra, majd a kévetkezd oldalon talalhato példanal javitsa ki a hibat.

Az F8 billentyl lenyomasaval az egész dokumentumra is kiterjesztheti az
ellendrzést.

d)Tipp A Verification Message Details (Uzenet részleteinek megjelenitése)
parbeszédablak hasznalataval attekintheti és néha automatikusan kijavithatja a
hibakat. Tovabbi részletekért lasd az SDL Trados Studio on-line sugdjat.
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Behelyezhetd elem beillesztése

A behelyezhet6 elemek olyan forrasnyelvi tartalmak, melyeket nem kell forditani, vagy olyan
tartalmak, melyeket a forditasi memoaria alkalmazaséaval automatikusan lokalizalni lehet.
A behelyezhetd elemeket az Editor (szerkeszt6) ablakban a program kék alahuzassal jeldli.

J2 cm

11. Mddositsa a 4. szegmens forditasat és illessze be a helyes behelyezhetd elemet (12 cm):

Dokumentumok forditasa és ellen6rzése — Els6 1épések utmutatd
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Torolje a célnyelvi szegmensbdl a széveget.

Masolja vagy gépelje be a kdvetkezd szOveget a célnyelvi szegmensbe: Auf der
Riickseite des Fotodruckers sollte fiir problemlosen Papiertransport ein Abstand von

mindestens

Nyomja meg a Ctrl+,(vesszd) billentylikombinaciét. Megjelenik a QuickPlace legordilé
lista. EQy korabbi példanal a QuickPlace legorduld lista formazasi beallitasokat mutatott,
most a forrasnyelvi szegmensben szereplé szamot mutatja, melyet Onnek a célnyelvi

szegmensbe kell beillesztenie.

Place the photo printer on a flat, clean and dust-free
surface, in a dry location, and out of direct surlight

Allowe at least 12 cm clearance from the back of the

photo printer for the paper o fravel.

When connecting power or USB cables, keep the
cables clear of the paper path to the front and rear of

QuickPlace
leg6rdild
lista

Platzieren Sie den uf einer flachen,
sauberen Lnd staubfreien Obérflache, und stellen Sie
hn an einem trockenen Ocfauf, der feiwem diredtar
Sonnenlichit ausgeseizt gl
Lassen Si

12 cm
Achten Sie beim Yerbinden der Stromversorgung
bzw. des USB-Kabels darauf, dass die Kabel den

Ahhoz, hogy a 12 cm behelyezhetd elemet kivalassza a listdbdl, nyomja meg az

Enter vagy Tab billentyt.

A forditdas maradék részét masolja vagy gépelje be: gelassen werden.

A forditas jévahagyasahoz nyomja meg a Ctrl+Enter billentylikombinaciét.

Ezuttal nincsenek ellenérzési hibak.
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AutoSuggest hasznalata

Az AutoSuggest funkcio figyelemmel kiséri az On altal begépelt szavakat és néhany karakter
begépelése utan az AutoSuggest eréforrasok olyan szavakat, mondatokat javasolnak célnyelven,
melyek ugyanazokkal a karakterekkel kezdédnek. Az AutoSugest a kdvetkez6 eréforrdsokat
hasznalja:

¢ terminoldgiai adatbazisok

o AutoSuggest szétarak (kétnyelvii mondattoredékek a forditasi memaoriabdl),

o AutoText bejegyzések,

o forditasi memoriak, gépi forditd szerverek és konkordanciakeresési talalatok.

Tovabbi informaciokért lasd az

Er8forrasok fejezetet.
12. Az AutoSuggest segitségével forditsa le a 9. szegmenst:

e Helyezze a kurzort a 9. szegmensbe. Nyomja le a H betlit. Az AutoSuggest lista

megjelenik a szegmens alatt. A Hinweis sz6 hasznalatat javasolja. A E szimbolum
mutatja, hogy a javaslat forrasa a forditasi memoaria. A javaslat beillesztéséhez nyomja
meg az Enter billenty(t.

AutoSuggest
—— lista

15

q r_\h:lte:

10 Use only the AC power adapter included with

your photo printer. thalten ist.
1 Other adapters can damage your camera, A i | Andere Adapter kiinnen Ihre Kamera,
photo printer, or computer. Fotodreucker. bzw. Computer beschéadigen.

45 To connect and turn on the power, follow these steps: 4 ANl  So verbinden Sie das Netzkabel und schalten Sie das

 irjon egy kettéspontot és a szegmens elfogadasahoz nyomja meg a
Ctrl+Enter billentylkombinaciot.

13. A kurzor automatikusan a 10. szegmensbe kerll. Az AutoSuggest segitségével forditsa le a
szegmenst:

e Gépelje be a kdvetkez6 forditast az AutoSuggest listajan szerepld ajanlott kifejezéseket
hasznalva (a félkdvér betlik azokat a szavakat vagy téredékeket jeldlik, amelyeket az
elsé betli begépelését kdvetben be tud illeszteni az AutoSuggest listabdl): Verwenden
Sie ausschlielllich das Netzteil, das im Lieferumfang des Druckers enthalten ist.

e Gépelje be a Fotodrucker F betiijét. A kdvetkez6 javaslatok jelennek meg. A listan
szerepelnek javaslatok a terminoldgiai adatbazisbdl és a forditdsi memoridbdl egyarant.

A a szimbolum mutatja, hogy a javaslat forrasa a terminoldgiai adatbazis. Ebben az
esetben kétszer szerepel a Fotodrucker a javaslati listan, hiszen megtalalhaté a
terminoldgiai adatbazisban és a forditasi memariaban is. Pontosabb forditast tesz
lehetdvé, ha a javasolt kifejezés két kuldnb6z6 forrasban is megtalalhato.

e Hasznalja a nyil billenty(iket a Fotodrucker egyik verzidjanak kijeldléséhez,
majd nyomja meg az Enter billenty(it a javaslat beillesztéséhez.

10 Use only the power adapter included with your & VYerwenden Sie ausschlieBlich das Netzteil, das im
photo printer. Lieferumfang des flenthalten ist.
Other adapters can damage your camera, photo A cia | Andere Adapter 3 fotodrucker
printer, or computer. Computer besch [ fotodrucker

12 To connect and turn on the power, follow these steps: A i | So verbinden Sie c [ fotopapier

— fatas
Y &l zegments NS Dﬂ.ﬁfolg
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e A szegmens jovahagyasahoz nyomja meg a Ctrl+Enter billentylkombinaciot.

Az AutoSuggest hasznalata gépi forditas hozzaadasaval

Az AutoSuggest funkcié gépi forditas hozzaadasaval térténd hasznalata hatékony eszkdzként
szolgalhat azok szamara, akik épp most kezdtek el dolgozni egy kisméretii forditasi memoria
vagy terminologiai adatbazis hasznalataval.

14. A funkcié megfeleld hasznalatahoz végezze el a kovetkezd lépéseket:

e aFile > Options > AutoSuggest (Fajl > Beallitasok > AutoSuggest) meniben az
AutoSuggest er6forrdsoknal tegyen pipat a Translation Memory and Automated
Translation (Forditasi memoéria és automatizalt forditas) jel6lénégyzetbe;

e akFile>Options > AutoSuggest > Translation Memory and Automated
Translation (Fajl > Beallitdsok > AutoSuggest > Forditasi memoéria és automatizalt
forditas) menudben tegyen pipat az Automated translations (Automatizalt forditasok)
jelélénégyzetbe;

e aFile > Options > Editor > Automation (Fajl > Beallitasok > Szerkeszt6 >
Automatizalas) mentpontban vegye ki a pipat az Apply automated translation
when no TM match is found (Automatizalt forditas alkalmazasa, amikor a program
nem talal egyezést a forditasi memariaban) jel6lénégyzetbdl.

Ezt kdvetben valos idében tarthatja kézben a forditasi folyamatot kézvetlendl az Editor
(Szerkesztd) nézetben. A gépi forditas (MT) eredménye nem keril be kézvetlendl a célnyelvi
szegmensbe, hanem a Translation Results (forditasi eredmények) ablakban jelenik meg,
igy elddntheti, milyen legyen a végleges forditas:

English-German,S0OL Language Cloud - Translation Results 1

wy ProjectSettings Hy B B ¥
Other adapters can damage your camera, photo printer, or computer.

Other adapters can damage your camera, photo Andere Adapter konnen die Kamera beschadigt, Foto
printer, or computer. Drucker oder Computer.

Ha a 11-es szegmensben gépelni kezd, a gépi forditdbmotor altal kinalt forditasi
javaslatok is megjelennek a listaban, ahonnan ki tudja valasztani a megfelelének talalt

javaslatot.
1 Other adapters can damage your camera, photo printer, or & Ande!
computer. 3l Andere Adapter kdnnen die Kamera beschadigt
12| To connect and turn on the power, follow these steps: O 31 Andere Adapter konnen die Kamera
13/ Step D B Andere Adapter kdnnen
Mot 5l Andere Adapter
14| Motes O 5 Andere
Connect the AC power cord to the AC power adapter, then to the back [

= of the photo printer.

Arra is lehet6sége van, hogy a forditastdredékeket a célnyelvi szegmensbe térténd beillesztést
kovetben rogtdn megszerkessze, szemben azzal, mintha a teljes gépi forditas célnyelvi
szegmensbe val6 behelyezését valasztotta volna, és a teljes célnyelvi szegmenst utélagosan
kéne megszerkesztenie.
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A forditas elbnézete

Munka kdzben is megtekintheti a forditas elénézetét. A valos ideji elénézet mutatja a valtozasokat
gépelés kdzben. Az el6nézet minden alkalommal frissil, amikor jovdhagy egy szegmenst.

Ez a fajta elénézet a gyakran hasznalt fajlformatumok, mint példaul a Microsoft Word és a HTML
esetében érhetd el.

MEGJEGYZES A dokumentumok elénézetét megtekintheti abban az alkalmazasban is,
amelyben azok eredetileg készlltek, vagy bongészéjében megtekintheti
a kétnyelv(i dokumentum nyomtatasi képét is. Tovabbi informaciét az
SDLTrados Studio sugdjaban talal

15. A forditas el6nézete:

e Vigye a kurzort a Preview (Elénézet) fllre az alkalmazas jobboldalan.
A Preview (El6nézet) ablak jelenik meg.

I B Translation Results 3 TQAs @ Termbase Search [5 -4 & O al
tomization  o¥ Concordance Search & Messages @ Termbase Viewer [I] & & % . Elénézet fil
"o Lot B Comments B Term Recognition @& Preview g L' L *) /
Infarmation Actio,.  Options | FONt A md
|=| B Term Recognition [« 0 % |&
IMotes [) Show Messages for Active Docurnent Only : RGEO %3
= Qngin Doc IMMH& g
gent o 15 ol properly 1A Checker 30 Gy | Fotodcker

k

man - Concorda.. [ Comments(0) ' TQAs(0) €3 Messages(1) | | Temn Recogrtion |[F Tembase Seaich

E]l | SamglePhotoPrinter doc, sdbdif [Translation]” | SecondSample docx. sdikif [Translation]” 4/p ¥ X
behindern. -

| 4  Sorgen Sie fir problemiose I.I—|
Balifung

e Kattintson a rogzités - szimbdlumra a megjelenitett ablak régzitéséhez.
Az el6nézet ablak a jobboldali alsé sarokba kerul.

Prewview - EK\@' Kattintson
S
. . ; o erre a
Wiewr  Real-time Preview = @) 5 megnyitott
o
Source T arget = ablak
rogzitéséhez.

Kattintson ide

/ az eldnézet

/ létrehozaséhoz.

Click _here to generate initial preview

A Preview (El6nézet) ablakban kattintson a Click here to generate initial preview
(Kattintson ide az elénézet Iétrehozésahoz) linkre. A dokumentum a Preview (El6nézet)
ablakban tekintheté meg.
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A Preview (El6nézet) ablakban a leforditott és jovahagyott tartalmak jelennek meg.

A forditasra és jovahagyasra varé angol elemeket is megjeleniti. Az On altal épp szerkesztett
szegmens (a 11-es szegmens) szirkével van kiemelve. Ez az angol forrasnyelvi széveget mutatja,
mert még forditésra var a szegmens.

Preview * 1 X
View: |Real-ﬁme Preview |w | P
| SDurDe| | Target |
i
Erste Schritte
Aufstellungsort fiir Ihren Fotodrucker finden
" Platrizren 3i2 den Fotodmucksr suf smer flachen, ssubsrsn und stzubfreien Oberfliche, und stellen Sis
thn =n smem trecksnsn Ort zuf, dor kemem dirskten Sconmenlicht zusgasstzt ist.
o Anfder Rilckssite des Fotedruckers sollte fir problemlosen Pepisrtransport sim Abstand von
mindestens 12 cm pelassen werden. When connectmg power or USE cables, keep the cables clear of
the paper path to the front and rezr of the phote printer.
A
» Fot propsr ventilztion®, mzks surs the top znd back of the photo printer 2rs net blocked. kivalasztott
Connecting and turning on the power [ szegmens
N Hinweis: Verwenden Sie ausschlieBlich das Netzteil, das im Lieferumfan
des Druckers enthalten ist Fﬂtodrucker.lﬂther adapters can damage your |
[camera, photo printer, or computer. |
To connect and turm on e power, Tonow mese steps:
Step Notes
1. Connect the AC power cord to the AC The AC power cable included with yvour
power adapter, then to the back of the photo printer may not require assembly, s
photo printer. and may be different from the one shown. o
o | Filigm dlom A7 mmieme mmb s fimbm = mmgeme &
|N|:|rma| V| |Fit to width V|

e Az AutoSuggest listajan szerepl6 ajanlott kifejezéseket hasznalva gépelje be a
kovetkez6 forditast a 11-es szegmens célnyelvi helyére (a félkdvér betlik azokat a
szavakat vagy téredékeket jeldlik, amelyeket az elsé betl begépelését kdvetéen be tud
illeszteni az AutoSuggest listabdl):

Andere Adapter konnen lhre Kamera, Fotodrucker bzw. Computer beschadigen.

e A forditas jovahagyasahoz nyomja meg a Ctrl+Enter billenty(ikombinaciot.
A Preview (Elénézet) ablak frissul az uj forditassal.
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A mintadokumentum forditasa a PerfectMatch (tOkéletes egyezés)

alkalmazasaval

A PerfectMatch (tokéletes egyezés) olyan szévegkdrnyezeti egyezés, amely a frissitett forrasnyelvi
fajlokat a megfelel6 kétnyelvii dokumentumokkal veti 6ssze, nem pedig a forditasi memariaval.

A szegmensegyezések, azaz PerfectMatch-ek (tOkéletes egyezések) esetében a szOvegkdrnyezet
is ellendrzésre kerll annak biztositasa érdekében, hogy valéban ugyanaz legyen a két szegmens.
Ezek aztdn a mar meglévd kétnyelvii dokumentumokbdl a frissitett forrasfajlokba kerilnek. Mivel a
PerfectMatch (t6kéletes egyezés) szegmensek keresési folyamatanak része a szévegkdrnyezet
ellenérzése, a PerfectMatch egységek altalaban mar nem igényelnek tovabbi forditast vagy
szerkesztést.

Forditas PerfectMatch egyezésekkel

Tegytk fel, hogy az elébbi példaban leforditott fotdnyomtatdé mintadokumentum teljes mértékben
forditasra és atnézésre kerilt. Megjelenik a fotonyomtato 2. verzioja, ezért némi széveggel
kiegészilt a dokumentum.

Mivel a dokumentum alapvetéen megegyezik az el6z6 dokumentummal, a projektvezetd a
PerfectMatch (t6kéletes egyezés) alkalmazasaval eléforditotta a fajlt. Ez a korabban leforditott
dokumentum forditasait illeszti be a dokumentum Uj valtozataba PerfectMatch (t6kéletes)
egyezésekként.

1. AFiles (Fajlok) nézet megjelenéséhez kattintson a navigacios ablak Files (Fajlok) gombijara.

2. Jobb egérgombbal kattintson a TryPerfectMatch.doc.sdIxliff fajlra és valassza az
Open for Translation (Megnyitas forditasra) menipontot a helyi menibél.
A fajl automatikusan megnyilik az Editor (Szerkeszt6) nézetben.

! i Eme feladat kdvetéséhez hasznadlja az alkalmazas Sample Project nevd fajljat.
Ha nem ez az aktiv (éppen kivalasztott) projekt, akkor valtson a Projects (Projektek)
O nézetre és kattintson kétszer a Sample Project sorra.

...Documents\Studio 2015\Projects\ Samples\SampleProject\
en-US\TryPerfectMatch.doc

3. PerfectMatch (t0kéletes egyezés) talalhatdé a dokumentum szegmenseinek jo részében.
PerfectMatch forditasok:

. |:] - Mutatja a forditas eredetét, amely alapjan ez egy PerfectMatch
(tokéletes egyezés).

. ;v"" - A szegmens allapota Signed off (végleg jovahagyott). Ez azt jelenti,
hogy a forditasok nem igényelnek tébb munkalatot vagy attekintést.

™
. - Mivel tovabbi feladat nincs vellk, a program zarolja, ezaltal megdévva a
véletlenszer( szerkesztéstol.
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SDL Tradas Studio - Sample Project -
aced Wiey Add-Ins Help
QO biuw 4 - o0& 8 9| B o Q-
V xx,m ©® ™ «» % a8 MR :
wnplete Clear Concordance Confirm Reject Go
eview | M T Fommatting - | B2 W we Search» B - Segment w4 Ci'T|  Tow
ns Farmatting QuickInsert G Translation Mer,, &0 Ter,, & Segment Actions L Mavigatio
_ _ Zarolt és
SecondS armple. docx. sdlliff [Translation]” ,
L CKMENMDOCUMEN veg le g9
1 Getting Started jovahagyott
o . . tokéletes
Finding a location for your photo printer -
2 egyezések
Place the photo printer on a flat, clean and dust-free surface, in a Flatzieren Sie den Fotodrucker auf einer flachien, sauberen
3 dry location, and out of divect sudight, Lind staubfreien Oberflache, und stellen Sie hn an einem
krockenen Ort auf, der keivem direktern Sonnaniicht
lsusgesatztist,
Allow at least 12 cm clearance from the back of the photo printer 1%, 0l & Jeuf der Ruckselte des Fotodruckers sollte fir problemiosen
4| for the paper o fravel, Papiertransport ein Abstand von mindestens 12 cm
belassen werden,
Wihen cannecting power or USE cables, keep the cables clear of the |2, 0l & Jechiten Sie beim Yerbinden der Stromversorgung bzw, des
5| paper path to the front and rear of the photo printer. | SB-Kabels darauf, dass die Kabel den Papierpfad nicht
behindern.
Far proper 2, 0l & Forogen Sie fur problemiose
PERIEININE] <foctrotereferent yle="Foothate Reference” autonurmber="1": § Pelifung
6| rmake sure the top and back of the photo printer are not blocked, <fo efere ence" a her="1"i= |
. Rlckseite des Fotodruckers nicht
blockieren.
Allow enough space on all sides of the photo printer 1o et you %, ull & |assen Sie genligend Abstand zu allen Seiten des
; connect and disconnect cables, change the calor cartridge, and add Fotodruckers, damit Sie jederzeit Kabel verbinden und

paper.

trennen, die Farbpatrone auswechseln bzw. Papier
hinzufligen kinner,

A megjelenitési szlr6 hasznalata uj tartalom megjelenitéséhez

4. Ahhoz, hogy a megjelenitési szlr6 kilistazza a PerfectMatch funkcidval (tokéletes egyezéssel)

még le nem forditott Uj tartalmat:

e Menjen a Display Filter (Megjelenitési szlir6) csoportra az Editor nézet Review

(Ellenérzés) fulén.

Megjelenités

|T|

Y Y | Search

Mot In
translated = | Source -

legdrdiils
lista .
ad Caze Sensitive

#F Refresh Filters

Y. ResetFilters

Dizplay Filter

e A Display (Megjelenités) legordiild listabdl valassza ki a Not Translated (Nincs leforditva)

opciot.

5. A 8. szegmens megjelenik. Ez az egyetlen forditasra vard, Uj tartalom a dokumentumban.

o irja be a kdvetkez6 forditast: Dies ist ein neuer Satz.

i TryPerfectMatch. doc sdlxliff [Translationf

3| This is a new sentence. P

Uj tartalom

v X

TryPerfectMatch.doc,
 TryPerfectMatch.das,

o A forditas jovahagyasahoz nyomja meg a Ctrl+Enter billentylikombinaciot.
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6. Ezzel végzett a dokumentum forditasaval. A médositdsok mentéséhez kattintson a H
Save (Mentés) gombra és zarja be a dokumentumot.

Attekintéskor csak a 8. szegmens tartalmat kell ellenérizni, hiszen az dsszes tébbi PerfectMatch
(tokéletes egyezések) mar atment az ellenérzd folyamaton.
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Ellenorzés az SDL Trados Studio-ban

Mindkét dokumentum forditasat kdvetéen On vagy egy kilén lektor leellenérizheti a forditasokat.
Ha az el6z6 rész dokumentuma még mindig nyitva van, akkor mentse el és zarja be azt.

MEGJEGYZES Amennyiben egy olyan lektorral dolgozik, aki nem rendelkezik Studio-
val (pl. egy szaklektor), a fajlt exportalhatja Wordben torténé
lektoralashoz is. Tovabbi informaciét az SDLTrados Studio sugéjaban
talal

A mintafajl megnyitasa és ellendrzése

l i Eme feladat kovetéséhez hasznalja az alkalmazas Sample Project nevd fajljat.
Ha nem ez az aktiv (éppen kivalasztott) projekt, akkor valtson a Projects
o (Projektek) nézetre és kattintson kétszer a Sample Project sorra.

...Documents\Studio 2015\Projects\Samples\SampleProject\

Sample Project.sdlproj
1. AFiles (F3jlok) nézet megjelenéséhez kattintson a navigacios ablak Files (Fajlok) gombijara.
2. Jobb egérgombbal kattintson a SamplePhotoPrinter.doc.sdIxliff fajlra és valassza az

Open for Review (Megnyitas ellen6rzésre) menipontot a helyi menibél.
A fajl automatikusan megnyilik az Editor (Szerkeszt6) nézetben.
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) % Open For Sign-off [E, Open File Externally + Add Folders B
Project Open For Batch . . _
Settings Translation Tasks= [G Open File With Add Mew Folder [
Configur.., Open File Actions
Files < M arne “Wards Status Progress
I@] TrvPerfecthd atch, doc. sdllift 224 |n Translat... m
EGerman (Germnany) - @ SecondSample. docs. zdlxlif # Open For Translation
Froject folders :'D SampIeXML_DITf&.:-:mI aTTpen For Review >
= Sample Project Il‘__'lj SampleF’resentatlf:un.ppt:-: % Open For Sign-off
by Tasks ] SamplePhotoPrinterdoc.sd.  —
3 Sent Tasks Batch Tasks »
{!J Translate [to yohnb) &  Create Project Package
P&  Create Studio 2009 Package
@
* Explore Containing Folder
=
[G  Dper File With
File Details -
MHame TmyPerfecttatch
[[] Include subfalders Path CAllsershcadam!| = =E
lzage Tranzlatahle Eﬂ
""""" Lazt Modified BA4/2015 12151
& welcome Size E3KE
Original Mame TrPerfecttdatzh, E; Lhange Phase r
wy Frojects File Type Identifier  ‘wford 2000-2003 &  Assign to Users in Phase »
< = — Wwiords 224 ) Add Files
S 3+ Add Folders
E Reports
Add Mew Folder

ﬂéﬂg SamplePhotoPrinter.doc.sdIxliff a Sample Project-ben.

Amikor megnyit egy fajlt ellendrzésre, a képernyd elrendezése az Editor (Szerkeszt§) nézetben
megvaltozik, és megjelenik az a szegmensallapot lista, amely kifejezetten az ellenérzési
allapotokra vonatkozik.
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Forditasok jévahagyasa

Amikor végzett egy szegmens ellenérzésével, jova kell hagynia vagy el kell utasitania a forditast.

3. Ahhoz, hogy jévahagyja a forditast, helyezze a kurzort a célnyelvi forditas 1. szegmensébe és
nyomja meg a Ctrl+Enter billentylikombinaciét vagy kattintson a Confirm

(Translation Approved) (Jévahagyas, forditas jovahagyasa) = # gombra az Editor nézet
Home flilének Segment Actions (Szegmens mi{iveletek) csoportjaban.

Forditas jovahagyasakor:
e A szegmens allapota Approved-ra (jévahagyottra) valtozik és a kdvetkezé ikon jelenik
meg a szegmensallapot oszlopban: = v

e A szegmens ellendrzése is lefut. A szegmensellendrzési hibak a Messages (Uzenetek)

ablakban jelennek meg J6vAR £t
6vahagyo

///////, fordités

erbinden und AnschlieBen

¢ Connecting and turning on the power
g Note:
10| Use only the AC power adapter included with your photo printer.
11 Other adapters can damage your camera, photo printer, or computer.

=
[
o

Forditasok elutasitasa valtozasok kovetésével

A valtozasok kévetése funkcio lathatova teszi a forditott szoveg barmely valtoztatdsat az eredeti
szbveggel egyitt. Ezaltal az eredeti szOveg és a javaslatok 6sszehasonlithatdk. A funkcid
automatikusan bekapcsol, amikor az Open for Review (Megnyitas ellenérzésre) parancsot
valasztja.
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A 2. szegmensben a photo printer jelenlegi forditasa Fotodrucker. Tegyuk fel, hogy az ugyfél
megkérte Ont, hogy a forditas soran a Drucker szét hasznalja. A Track Changes (valtozasok
kovetése) funkcio segitségével egy masik kifejezést javasolhat a Fotodrucker helyett.

4. Amikor a legutolso 1épésnél jévahagyta a forditasat, akkor a kurzor automatikusan a
kovetkezd jovahagyasra varo, 2. szegmensre ugrott. Tordlje a Fotodrucker szét, és irja be
helyette a Drucker kifejezést. Amikor ezt teszi:

e A Fotodrucker piros vonallal athuzva jelenik meg, ezzel jelezve, hogy térdlte a szot.
A Drucker pedig lilan, egy vonallal alahtzva jelenik meg, igy jel6lve, hogy beillesztette
ezt a sz6t. Amikor a dokumentum visszakerl a forditéhoz, 6 a jobb egérgomb
segitségével minden egyes esetben elfogadhatja vagy elutasithatja a valtozasokat.

e A szegmens allapota Rejected-re (elutasitottra) valtozik és a kdvetkezd ikon jelenik

meg a szegmensallapot oszlopban:

Connecting and turning on the power
Note:
Use only the AC power adapter included with your photo printer.

Verbinden und AnschlieBen
Hinweis:

s Netzteil, das im Lieferumfang d
Feledrmelers _Eg_mﬂmbnt alten ist.
\
Automatikusan

elutasitott \ Valtozéasok

fordités kovetése

Other adapters can damage your camera, photo printer
Ta connect and turn an the pawer,

=Ty

Forditasok elutasitasa megjegyzések hasznalataval

Megjegyzések hozzaflizésével elmagyarazhatja, hogy mi a hiba a forditasban. Megjegyzést flizhet
az aktudlis célnyelvi szegmenshez, a kivalasztott széveghez vagy akar az egész dokumentumhoz.
Adjon hozza egy megjegyzést a 2. szegmenshez, amelyben megindokolja, hogy miért cserélte a
Fotodrucker kifejezést Drucker-re.

5. Jeldlje ki a forditas 2. szegmensében a FotodruckerDrucker kifejezéseket és nyomja meg a
Ctrl+Shift+N billentyllkombinaciét vagy jobb egérgombbal hivja be a helyi menit és valassza
az Add Comment (Megjegyzés hozzdadésa) parancsot.

Toltse ki a parbeszédablakot a lent lathaté médon, majd a megjegyzés hozzaadasahoz kattintson
az OK gombra.

Add Comment

Scope [Current Selection - ]

Comment information
Severity level [ Ermor - ]

The customer has requested that you change the translation for photo printer to Drucker
instead of Fotodnucker]

[ ok | [ cameal | [ Hep |

A megjegyzés igy megjelenik a Comments (Megjegyzések) ablakban. Amikor hozzaadta ezt a
megjegyzést:

e A szdveg, amelyhez a megjegyzést flizte, halvanypirossal ki lett emelve,
amely azt jeldli, hogy a megjegyzés szigorusagi szintje Error (hiba).
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e Ha a szegmenst még nem utasitottak el, a szegmens allapota Rejected-re (elutasitottra)

valtozik és a kdvetkez6 ikon jelenik meg a szegmensallapot oszlopban: © .

®Tipp A megjegyzéssel ellatott széveg halvanysarga kiemeléssel jelenik meg,
ha a szigorusagi szintje tajékoztatod jellegli vagy halvany narancssarga,
ha figyelmeztet6 jelzésrdél van szo.

kiemelés

- e e P o e s

Forditasok manualis elutasitasa

Manualisan is elutasithatja a szegmenseket. Mivel a megjegyzésben jeldlte, hogy a Drucker
kifejezést szeretné hasznalni a Fotodrucker helyett, utasitsa el az 6sszes tobbi forditast.

6. Ahhoz, hogy jévahagyja a forditast, helyezze a kurzort a 3. szegmensbe és nyomja meg a

Ctrl+Shift+Enter billentylikombinaciét vagy kattintson a = *f Reject (Translation Rejected)
(Elutasitas, forditas elutasitasa) gombra az Editor nézet Home fllének Segment Actions
(Szegmens miiveletek) csoportjaban.

7. A szegmens allapota Rejected-re (elutasitottra) valtozik és a kdvetkezd ikon jelenik meg a

szegmensallapot oszlopban: «
Manudlisan
elutasitott

Verbinden L?Anschlieﬂen
Hinweis:

Connecting and turning on the power £ 1002

Note: e

Use only the AC, power adapter included with your photo Verwenden Sie ausschlieBlich das Netzteil, das im
printer. Lieferumfang des Eotodruckers enthalten ist.
Other adapters can damage your camera, photo printer, or FATEre FAdapter Konnen Ihre Kamnera (a1
computer. bzw. Computer beschadigen.

Forditasok elutasitasa a TQA funkcié hasznalataval

A Translation Quality Assessment (TQA) (Forditasok min&ségértékelése) funkcio alakjaban az
ellendrzés egy fejlettebb maodjara is lehetésége van. A funkcid hasznalataval egyedi minéségi
kritériumok alapjan mérheti a forditasok min6ségét.

Hatarozza meg azokat a min6ségi mutatdkat, amelyek alapjan mérni kivan, mérlegelje
jelentésegiket és allitson 6ssze egy TQA keretrendszert. Ez a keretrendszer a forditasok
értékelésekor Utmutatast nyujt az ellenérzést végzének és lehetévé teszi, hogy a Studio
automatikusan hatarozza meg a forditasok minéségét.

Tovéabbi informacidkért lasd a Hogyan dolgozzunk a TQA funkcidval fejezetet.

Dokumentumok forditasa és ellenérzése — Elsé |épések Utmutatd

46. oldal


http://producthelp.sdl.com/SDL_Trados_Studio_2015/client_en/About_TQA.htm

SDLS$

A fennmarado szegmensek jovahagyasa

Tegyuk fel, hogy befejezte a teljes dokumentum ellendrzését és nem utasitott el egyéb
forditasokat. Egyszerre jovahagyhatja a maradék szegmenseket.

8. Az 6sszes olyan forditas jovahagyasahoz, amelyet még nem utasitott vagy fogadott el:

e Kattintson a = % gombra.
e Megjelenik egy lizenet. Olvassa el, majd kattintson a Yes (igen) gombra.

¢ Minden olyan forditas, amelynek allapota nem Translation Approved
(Forditas jovahagyva) vagy Translation Rejected (Forditas elutasitva)
Translation Approved (Forditas jovahagyva) allapotot kap,
majd a program elmenti és bezarja a dokumentumot.
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Javitasok végrehajtasa

Amikor egy dokumentumot ellenériz vagy a mar ellenérzott dokumentumon javitasokat eszk6zdl,

akkor a képerny8sz(irok segitségével rakereshet azokra a szegmensekre, melyeket még
ellendrizni vagy javitani kell.

Szegmensek ellendrzéséhez hasznalhaté megjelenitési sziirék
Az SDL Trados Studio olyan sziir6ket tartalmaz, melyek segitségével rasziirhet az ellendrizni
kivant forditasokra. Amikor egy dokumentumot ellendriz vagy a lektor visszajelzése alapjan
javitasokat végez, akkor két f6 kategoriat kildonbdztetiink meg.

Ellendrzési sziir6é kategoriak Leiras

A szegmensek allapota alapjan torténé sziréshez
hasznalhatja ezt.

Segment Review Statuses Példaul beallithatja, hogy csak a Translation rejected
(Szegmensek ellendrzési allapota) (Forditas
elutasitva) allapotu szegmensek jelenjenek meg a
képernydn, igy csak azokat a szegmenseket kell
ellendriznie, melyek javitasra szorulnak.

Ezt olyan forditasok megtekintéséhez hasznéalhatja, melyek:

e visszajelzéssel rendelkezé megjegyzéseket
Segment Review tartalmaznak,

(Szegmens ellendrzése) e valtozasok kovetésével végzett modositasokat
tartalmaznak vagy

o ellendrzés soran fellépd hibakkal kapcsolatos
Uzeneteket tartalmaznak.

A szir6k az Editor nézet Review (Ellen&rzés) fulének Display Filter (Megjelenitési sz(ir8)
csoportjabdl is kivalaszthatok.

Y ?" Bearch

Al In ad Cases
segrments = Source T
all -
| General

Al segrments
&)l content

Segment Review Statuses

Tranzlated o
Ellenérzéshez
hasznalt
Translation rejected szurék

Signed off

Translation approved —— T

Slapn off rejected

Seqment Review
' Mot translated
| Draft
Repetitions

|
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Megijelenitési szlir6k hasznalata

Tegyuk fel, hogy megkapta a forditast ellenérzé személy javitasait. A javitast igénylé szegmensek
megtalalasahoz hasznalja a megjelenitési szliréket.

Ha az el6z6 rész dokumentuma még mindig nyitva van, akkor mentse el és zarja be azt.

E i Eme feladat kdvetéséhez hasznalja az alkalmazas Sample Project nevi fajljat.
Ha nem ez az aktiv (éppen kivalasztott) projekt, akkor valtson a Projects (Projektek)
O nézetre és kattintson kétszer a Sample Project sorra.

...Documents\Studio 2015\Projects\Samples\SampleProject\
Sample Project.sdlproj

1. AFiles (Fajlok) nézetben jobb egérgombbal kattintson a SamplePhotoPrinter.doc.sdIxliff fajlra
és a gyorsmenibdl valassza ki az Open for Translation (Megnyitas forditasra) menipontot a
helyi menubél. A fajl automatikusan megnyilik az Editor (Szerkeszt6) nézetben.

2. Ajavitast igényl6 tartalom megjelenitéséhez allitsa be a sziirét ugy, hogy csak a
Translation Rejected (Forditas elutasitva) allapotu szegmenseket mutassa a program.

e Kattintson a Translation rejected gombra a Review (Ellen&rzés) ful Display Filter
(Megjelenitési sz(ir6) csoportjaban.

Megjelenités

Legordild

lista

Y v' Eearch -

Translation In ad Case Sensitive  “f Refresh Filters §§ Reset Filters
rejected = | Source v

Display Filter

Csak a 2. és 3. szegmens jelenik meg. Ezeket a szegmenseket az ellen6rzést végzé személy
elutasitotta az utolso feladatban, mivel az tigyfél azt kérte, hogy a Fotodrucker helyett inkabb a
Drucker terminust hasznalja.

Javasolt (valtozasok kovetése) mddositasok elfogadasa

3. Fogadja el a javasolt médositasokat:

e Helyezze a kurzort a Fetedrueker terminusra, majd nyomja meg a Ctrl+Shift+F9
billentyllkombinaciét vagy jobb egérgombbal hivja be a helyi meniit és valassza az
Accept Change (Mddositas elfogadasa) parancsot. A program eltavolitja a sz6t a
forditasbal.

o Végezze el ugyanezt a miveletet a masik valtozasok kdvetésével végzett modositason,
a Drucker terminuson.

A forditas jévahagyasahoz nyomja meg a Ctrl+Enter billentyllkombinaciét.
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A leforditott, célnyelvii dokumentum létrehozasa

Tegyuk fel, hogy befejezte a mintadokumentum forditasat. Hozza létre a leforditott dokumentum
végleges, célnyelvl verzidjat.

4. Ha bezarta a SamplePhotoPrinter.doc.sdIxliff fajlt, akkor nyissa meg Ujra az
Editor (Szerkesztd) nézetben.

5. Valassza a File > Save Target As (Célnyelvii dokumentum mentése masként) opciot.

Mentse el a végs6 Word dokumentumot, példaul SamplePhotoPrinter-Translated.doc néven.

I@ [H ¥ - & ) = samplePhatoPrinter.doc [Compatibility Mode] - Microsoft Word - = X
¥ iaa) P
~ Home Insert Page Layout References Mailings Review View Dreveloper Add-Ins @

h e wlEm A M s

B L s x x|[B] || =

Paste = — = Cluick Change | Editing

b - A

- F YA A A A & Styles - Styles= | -

Clipboard ™ Font ] Paragraph F] Styles (F]

|| S

Erste Schritte
Aufstellungsornt fiir Ihren Drucker finden

* Platzieren Sie den Drucker auf einer flachen, sauberen und staubfreien Oberfliche, und stellen Sie
ihn an einem trockenen Crt auf, der keinem direkten Sonnenlicht ausgesetzt ist.

® Auf der Fiickseite des Dnickers sollte fiir problemlosen Papiertransport ein Abstand von mindestens
12 cm gelassen werden. Achten Sie beim Verbinden der Stromversorgung bzw. des USE-Kabels
darauf, dass die Kabel den Papierpfad nicht behindem.

* Sorzen Sie fitr problemloze Beliifung!, indem Sie die obere bzw. Riickseite des Fotodmickers nicht
blockieren.

Verbinden und Anschlieen

fa

ja &Y Hinweis: Verwenden Sie ausschlieBlich das Netzteil, das im Lieferumfang
des Fotodruckers enthalten ist. Andere Adapter knnen Ihre Kamera,
Fotodrucker bzw. Computer beschidigen.

So verbinden Sie das Netzkabel und schalten Sie das Gerat ein:
Schritt Hinweise

1. Verbinden Sie das Netzkabel erst mit
dem Metzteil und dann mit der Riickseite

Fur das im Lieferumfang des Druckers
enthaltene Metzkabel ist keine Montage t

des Fotodruckers.

erforderlich.

Page:1 of1 | Words: 180 | ¢35

Arabic [Saudi Arabia} | 5 |

HE'@'E-E.
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Munka visszakuldése

Tegyiik fel, befejezte az Onnek csomagban kiildétt 6sszes fajl forditasat, és most vissza szeretné
kildeni munkajat az tgyfélnek (altalaban a projektvezetének). Ehhez return package
(visszaklildend6 csomag) formaban kell visszakiildenie munkajat. Amint Iétrehozta a csomagot,
visszakuldheti azt e-mailben, feltdltheti FTP oldalra vagy hasznalhat barmely mas preferalt
modszert. A WorldServer csomagokat kézvetlendil fel lehet tolteni a WorldServerre.

MEGJEGYZES A munka visszakiildendd csomagban torténd leadasa csak akkor
haszndlhatd, ha a forditdsra szant fajlokat projektcsomagban kapta.

Visszakuldend6 csomag létrehozasa

1. AProject nézet Home filének > Packages (Csomagok) csoportjaban nyomja meg a
Create Return Package (Visszakiildend® csomag létrehozasa) gombot. A Create Return
Package (Visszakiildend® csomag létrehozasa) varazslé a Select Files (Fajlok kivalasztasa)
oldalon jelenik meg. A referenciafajlokat kivéve a lista tartalmazza a projekt valamennyi fajljat.

A mintaprojekt esetében nem all rendelkezésre a visszakuldend csomag
létrehozasa opcid, mivel eredetileg a fajlokat nem projektcsomag formaban
O kapta.

2. A Select Files (Fajlok kivalasztasa) oldalon pipalja be azokat a fajlokat, amelyeket bele
szeretne tenni a csomagba. Ha a felsorolt fajlok kdzil mar néhanyat visszakildott egy masik
visszaklldendd csomagban, azokat a program alapértelmezetten nem pipalja be.

3. A Return Package Options (Visszakluldendd csomag opcidk) oldalra Iépéshez kattintson a
Next (Tovabb) gombra.

4. A Save Return Package (visszaklldendd csomag mentése) parbeszédablak megnyitasdhoz
kattintson a Browse (Tall6zds) gombra. Valassza ki a helyet ahova a visszakuldendd
csomagot menteni szeretné, majd a visszakuldend6 csomag neveként a File name (fajlnév)
ablakba irja be a SampleProjectReturn nevet, majd kattintson a Save (mentés) gombra.

MEGJEGYZES Ha WorldServer csomagot kivan visszakuldeni, a Return Package
Options (Visszakiildendé csomag opciok) oldalon a Server (Szerver)
opcio kivalasztasaval kdzvetlen a WorldServerre is feltdltheti a csomagot.

5. Ha megjegyzeést szeretne flizni a visszakuldendd csomaghoz, akkor azt a Comment
(Megjegyzés) ablakban megteheti.

6. A csomag létrehozasahoz kattintson a Finish (Befejezés) gombra, majd lépjen a Creating
Return Package (Visszakiildendd csomag létrehozasa) oldalra.

7. Amint a csomag létrehozasa befejez8détt, a projektnév mellett szereplé allapot Completed-re
(készre) valt.

8. A Send Packages by Email (Csomag kuldése e-mailben) gombra kattintva e-mailben is
elkuldheti a visszakuldend6 csomagot a megfeleld személynek.

9. Ha mas modon szeretné elkildeni a csomagot, példaul FTP oldalra valé feltliéssel, akkor a
visszakuldend6 csomagot tartalmazé mappa megnyitdsahoz kattintson az Open Target
Folder (Célnyelvi mappa megnyitdsa) gombra.

10. A Create Return Package (Visszakildend6 csomag létrehozasa) varazslé bezarasahoz
kattintson a Close (Bezaras) gombra.
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Az Elso lépések utmutaté vége

Most mar tisztaban van azzal, hogy hogyan forditson és ellenérizzen dokumentumokat az
SDL Trados Studio-ban. Tovabbi informaciot az SDLTrados Studio sugojaban talal.
Ezt az SDL Trados Studio Help fllén talalhaté Help Topics (Sugé témak) gombra kattintva éri el.
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http://producthelp.sdl.com/SDL_Trados_Studio_2015/client_en/SDL_Trados_Studio_Help.htm
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Tudjon meg tébbet az sdltrados.tech-lingua.hu weboldalon.
Kovesse az SDL-t a Facebookon és a Twitteren.

Tovabbi informaciokért, megrendelésért és tandcsadasért latogassanak el honlapunkra vagy
keressenek elérhetéségeink barmelyikén.
www.tech-lingua.hu
TECH-LINGUA BT, hivatalos SDL Trados partner
E-mail: trados.sales@tech-lingua.hu; Telefon/Fax: 06-22/792 959
8000 Székesfehérvar, /-\nyos Pal utca 3, 2/8.

Copyright © 2015 SDL plc. - Minden jog fenntartva. Minden céges termék- vagy szolgaltatas megnevezés,
melyre a jelen kiadvanyban hivatkozunk, a vonatkozé tulajdonosok tulajdonat képezi.
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